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Overview
The Dell PowerEdge Servers Troubleshooting Guide provides troubleshooting procedures for issues that are related to Server 
Operating System, Server Hardware, and Server Management Software. This is generation-specific information, separating 
problem identification and solution.

The troubleshooting guide is divided into three main sections:

● Quick help - This section provides information about error code matrix, top trending issues, and solutions for the issues.
● Self-help - This section provides information about diagnostics, faq, related videos, server management software issues, and 

troubleshooting operating system issues.
● Get help - This section provides information about how to contact technical support and prerequisite to be gathered before 

contacting technical support, for faster issue resolution.

Flowchart represents guided steps on how to troubleshoot an issue if you have an error code or if you find the issue that is 
listed in the top trending issues.
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Figure 1. Flowchart

Topics:
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• Recommended tools
• Safety instructions
• Documentation resources

Recommended tools
You may need any or combination of the following tools to perform the removal and installation procedures:
● Key to the bezel lock. The key is required only if your system includes a bezel.
● Phillips 1 screwdriver
● Phillips 2 screwdriver
● Torx T8 screwdriver
● Torx T30 screwdriver
● Torx T15 screwdriver
● 5 mm hex nut screwdriver
● Plastic scribe
● 1/4-inch flat blade screwdriver
● Wrist grounding strap connected to the ground
● ESD mat
● Needle-nose pliers

You need the following tools to assemble the cables for a DC power supply unit:

● AMP 90871-1 hand-crimping tool or equivalent
● Tyco Electronics 58433-3 or equivalent
● Wire-stripper pliers to remove insulation from size 10 AWG solid or stranded, insulated copper wire

NOTE: Use alpha wire part number 3080 or equivalent (65/30 stranding).

Safety instructions
NOTE: Whenever you need to lift the system, get others to assist you. To avoid injury, do not attempt to lift the system by 

yourself.

CAUTION: Ensure that two or more people lift the system horizontally from the box and place it on a flat 

surface, rack lift, or into the rails.

WARNING: Opening or removing the system cover while the system is powered on may expose you to a risk of 

electric shock.

WARNING: Do not operate the system without the cover for a duration exceeding five minutes. Operating the 

system without the system cover can result in component damage.

CAUTION: Many repairs may only be done by a certified service technician. You should only perform 

troubleshooting and simple repairs as authorized in your product documentation, or as directed by the online or 

telephone service and support team. Damage due to servicing that is not authorized by Dell is not covered by 

your warranty. Read and follow the safety instructions that are shipped with your product.

NOTE: It is recommended that you always use an antistatic mat and antistatic strap while working on components inside 

the system.

CAUTION: To ensure proper operation and cooling, all system bays and fans must always be populated with a 

component or a blank.

NOTE: While replacing faulty storage controller, FC, or NIC card with the same type of card, after you power on the 

system; the new card automatically updates to the same firmware and configuration of the faulty one. For updating to the 

latest firmware and changing the configuration, see the Lifecycle Controller User's Guide at iDRAC Manuals.
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CAUTION: Do not install GPUs, network cards, or other PCIe devices on your system that are not validated 

and tested by Dell. Damage caused by unauthorized and invalidated hardware installation will null and void the 

system warranty.

Documentation resources
This section provides information about the documentation resources for your system.

To view the document that is listed in the documentation resources table:
● From the Dell Technologies support site:

1. Click the documentation link that is provided in the Location column in the table.
2. Click the required product or product version.

NOTE: To locate the model number, see the front of your system.

3. On the Product Support page, click Documentation.
● Using search engines:

○ Type the name and version of the document in the search box.

Table 1. Additional documentation resources for your system 

Task Document Location

Setting up your system For more information about installing and 
securing the system into a rack, see the 
Rail Installation Guide included with your rail 
solution. 

For information about setting up your system, 
see the Getting Started Guide
document that is shipped with your system.

PowerEdge manuals

Configuring your system For information about the iDRAC features, 
configuring and logging in to iDRAC, and 
managing your system remotely, see the 
Integrated Dell Remote Access Controller 
User's Guide.

For information about understanding Remote 
Access Controller Admin (RACADM)
subcommands and supported RACADM 
interfaces, see the RACADM CLI Guide for 
iDRAC.

For information about Redfish and its protocol, 
supported schema, and Redfish
Eventing implemented in iDRAC, see the 
Redfish API Guide.

For information about iDRAC property 
database group and object descriptions, see
the Attribute Registry Guide.

For information about Intel QuickAssist 
Technology, see the Integrated Dell Remote 
Access Controller User's Guide.

PowerEdge manuals

For information about earlier versions of the 
iDRAC documents.

To identify the version of iDRAC available on 
your system, on the iDRAC web interface,
click ? > About.

idrac manuals
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Table 1. Additional documentation resources for your system (continued)

Task Document Location

For information about installing the 
operating system, see the operating system 
documentation.

Operating System Manuals

For information about updating drivers and 
firmware, see the Methods to download 
firmware and drivers section in this document.

Drivers

Managing your system For information about systems management 
software offered by Dell, see the Dell 
OpenManage Systems Management Overview 
Guide.

PowerEdge manuals

For information about setting up, using, 
and troubleshooting OpenManage, see the 
Dell OpenManage Server Administrator User’s 
Guide.

OpenManage Manuals > OpenManage Server 
Administrator

For information about installing and using 
Dell SupportAssist, see the Dell SupportAssist 
Enterprise User’s Guide.

serviceability tools

For information about partner programs 
enterprise systems management, see the 
OpenManage Connections Enterprise Systems 
Management documents.

OpenManage Manuals 

Working with the Dell 
PowerEdge RAID controllers

For information about understanding the 
features of the Dell PowerEdge RAID 
controllers (PERC), Software RAID controllers, 
or BOSS card and deploying the cards, see the 
Storage controller documentation.

Storage Controller Manuals

Understanding event and 
error messages

For information about the event and error 
messages generated by the system firmware 
and agents that monitor system components, 
go to QRL > Look Up > Error Code, type the 
error code, and then click Look it up.

QRL

Troubleshooting your 
system

For information about identifying and 
troubleshooting the PowerEdge server issues, 
see the Server Troubleshooting Guide.

PowerEdge manuals
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Quick help 15G
This section covers information on top trending error codes and top trending issues reported for the generation of servers.

Topics:

• Error code matrix
• Top trending issues

Error code matrix

The error code matrix provides information about generic error codes, error messages, link to the Error and Event Message 
Reference Guide (EEMI), and related article if available for different 15th generation of PowerEdge systems.

Table 2. Error code matrix 

Error code Message Related KB article or link to EEMI guide

HWC8010 The System Configuration Check operation resulted in the 
following issue: arg1.

Follow the steps listed in the link

SWC5012 Unable to power on the host because an SL cable is connected 
to an unpowered device.

Follow the steps listed in the link

PSU0003 The power input for the power supply is lost. Follow the steps listed in the link

RDU0012 Power supply redundancy is lost. Follow the steps listed in the link

SEC0033 The chassis is open while the power is off. Follow the steps listed in the link

VDR7 Virtual Disk on RAID Controller in Slot has failed. Follow the steps listed in the link

PDR1001 Fault detected on drive in disk drive bay. Follow the steps listed in the link

PDR1016 Drive is removed from the disk drive bay. Follow the steps listed in the link

CTL137 The storage controller Integrated RAID Controller is unable to 
communicate to the BMC because either the storage controller 
or BMC is not responding to the commands either because of 
an internal error or the bus is in an error state.

Follow the steps listed in the link

PCI1318 A fatal error was detected on a component at bus device 
function.

Follow the steps listed in the link

UEFI0056 A PCIe error has occurred. Follow the steps listed in the link

HWC1001 The NDC is absent. Follow the steps listed in the link

FAN0029 Fan is either removed, incorrectly installed, or not present. Follow the steps listed in the link

SWC0001 Unable to save the network settings. Follow the steps listed in the link

SWC0088 Unable to retrieve the iDRAC DHCP IP address. Follow the steps listed in the link

MEM0001 Multi-bit memory errors detected on a memory device at 
location(s).

Follow the steps listed in the link

UEFI0108 One or more memory errors have occurred on the memory slot. Follow the steps listed in the link

UEFI0339 The Dual Inline memory module (DIMM) in the memory slot is 
disabled because of initialization errors caused by uncorrectable 
memory errors, invalid configuration, and others.

Follow the steps listed in the link

2
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Table 2. Error code matrix (continued)

Error code Message Related KB article or link to EEMI guide

UEFI0058 An uncorrectable Memory Error has occurred because a Dual 
Inline memory module (DIMM) is not functioning.

Follow the steps listed in the link

MEM8000 Correctable memory error logging is disabled for a memory 
device at location.

Follow the steps listed in the link

FAN0001 Fan RPM is less than the lower critical threshold. Follow the steps listed in the link

STOR0502 Unable to launch the RAID Configuration wizard. N/A

UEFI0060 Power that is required by the system exceeds the power that is 
supplied by the Power Supply Units (PSUs).

Follow the steps listed in the link

PWR1006 The system halted because system power exceeds capacity. Follow the steps listed in the link

SUP0507 Unable to download the Update Packages from the FTP server. N/A

SEC0031 The chassis is open while the power is on. N/A

SUP0538 Unable to update iDRAC with Lifecycle Controller, 4.11.11.11, 
A00.

N/A

SUP0537 Unable to continue the firmware update. N/A

PST0208 System BIOS has halted. Follow the steps listed in the link

UEFI0078 One or more Machine Check errors that are occurred in the 
previous boot.

N/A

CPU0704 CPU machine check error detected. N/A

UEFI0067 A PCIe link training failure is observed in Slot, and the device 
link is disabled.

Follow the steps listed in the link

UEFI0079 One or more Uncorrectable Memory errors occurred in the 
previous boot.

N/A

If the error codes are not listed in the table, see Error and Event Message Reference Guide on the link.

The Error and Event Message Reference Guide lists the messages that are displayed on graphical user interface (GUI), 
command-line interface (CLI), and stored in the log files. Messages are displayed or stored as a result of user action, automatic 
event occurrence, or for data logging purposes.

For information about the event and error messages that are generated by the system firmware and agents that monitor system 
components, go to qrl.dell.com > Look Up > Error Code, type the error code, and then click Look it up.

Messages are divided into three elements:
● Message: Indicates the actual message, and probable cause, wherever applicable.
● Recommended Response Action: Indicates the remedial tasks to be performed by the user to resolve an issue. 

Comprehensive information is given about the GUI navigation path (or RACADM and WS-Man commands) that helps is 
effective and fast resolution.

● Detailed Description: Provides more info about the error or event, where appropriate.

Top trending issues

The top trending issues for the 15G server components are listed below.

Table 3. Top trending issues for 15Gen PowerEdge Servers 

Issue Resolution

Dell PowerEdge R750 and R7525 servers that are configured 
with a rear 4x2.5" hard drive backplane may report fan errors 
in the system event and lifecycle logs

To troubleshoot, see link
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Table 3. Top trending issues for 15Gen PowerEdge Servers (continued)

Issue Resolution

PowerEdge R7515 with NVIDIA T4 GPU Detected Critical Xid 
Error, and GPU stopped processing

To troubleshoot, see link

PowerEdge R7525 Install OS failed from Intel X710 PXE boot 
and stuck at get client information screen

To troubleshoot, see link

PowerEdge R7525: IO sequential read throughput drops when 
testing with over 10 SSD drives simultaneously

To troubleshoot, see link

Boot Device Fully Qualified Device Descriptor Name Changes 
in 15G BIOS UEFI Boot Sequence After BIOS Update

To troubleshoot, see link

PowerEdge: R750 no Boot and have an Error "NvmExpress: 
NVMe device not ready"

To troubleshoot, see link

PowerEdge R550 (15G) - HWC8010 - The System 
Configuration Check operation resulted in the following issue: 
Config Error: SL Cable PLANAR_SL8 and CTRL_DST_PA1

To troubleshoot, see link

R250, R350, T150, T350: First power on need wait for 2-3 
mins and Power button LED is off after pressing the power 
button

To troubleshoot, see link

PowerEdge R350 new deployment can deploy Windows 
Server 2022 but unable to deploy Windows Server 2019

To troubleshoot, see link

VLT0204 - System Board PSx PG Fail voltage is outside of 
range

To troubleshoot, see link

Table 4. Top trending issues for drives 

Issue Resolution

How to troubleshoot a drive failure? To troubleshoot drive failure, see link.

What is predictive drive failure and how do we detect it? To know more on predictive drive failure, see link

How to troubleshoot drive sense errors for PowerEdge 
servers?

For issues related to Key Code qualifier and Sense Code 5D 
errors, see link

How to identify and troubleshoot if a drive shows a foreign 
configuration?

To troubleshoot, see link.

How to troubleshoot failed or degraded virtual disks? To troubleshoot, see link.

Table 5. Top trending issues for processors 

Issue Resolution

What is CPU IERR and why does it occur? For information about CPU IERR errors, see link

PowerEdge servers processor issue information and 
troubleshooting techniques?

To troubleshoot, see link.

Table 6. Top trending issues for PERC 

Issue Resolution

How to troubleshoot a foreign drive? To troubleshoot, see link.

How to troubleshoot and identify a failed drive from a RAID 
array?

To troubleshoot, see link.

How to create, initialize and troubleshoot PERC Controllers 
and RAID Arrays?

To troubleshoot, see link.

How to Troubleshoot SMART Errors on a Dell PowerEdge 
RAID Controller (PERC)?

To troubleshoot, see link.
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Table 7. Top trending issues for memory 

Issue Resolution

What is DDR4 Self-healing on Dell PowerEdge Servers with 
Intel Xeon Scalable Processors

For information about DDR4 Self-healing, see link

How to troubleshoot single-bit error (SBE) and/or multi-bit 
error (MBE) in memory?

To troubleshoot single-bit error (SBE) and/or multi-bit error 
(MBE) in servers, see link.

14G Intel and 15G Intel/AMD PowerEdge servers: DDR4 
memory: managing Correctable error threshold events

For information about DDR4 memory: managing Correctable 
error threshold events see link

How to resolve issues with errors MEM0701, MEM0702 and 
MEM0005?

For MEM0701, MEM0702, and MEM0005 errors, see link .

How to troubleshoot correctable memory error on a DIMM? To troubleshoot, see link.

How to do RCA and find out if a DIMM or DIMM slot is faulty? To troubleshoot, see link.

Table 8. Top trending issues for NIC 

Issue Resolution

How to troubleshoot virtual machine network connection 
issues (VMware)?

To troubleshoot, see link.
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Self help
This section covers information on frequently asked questions, troubleshooting videos, server management hardware and 
software issues, and operating system issues.

Topics:

• System diagnostics and indicator codes
• Enhanced Preboot System Assessment
• SupportAssist Enterprise
• Secure Connect Gateway
• Frequently asked questions
• Videos
• Troubleshooting hardware issues
• Server management software issues
• Troubleshooting operating system issues

System diagnostics and indicator codes
This section describes the diagnostic indicators on the system front panel that displays the system status during system startup.

The following sections contain information about the chassis LEDs and indicator codes for the Dell PowerEdge servers.

Power button LED

The power button LED is located on the front panel of your system.

Figure 2. Power button LED

Table 9. Power button LED 

Power button LED indicator code Condition

Off System is not operating, regardless of power supply available.

On System is operating, one or more of the non-standby power 
supply units are active.

Slowly blinking System is performing powering on sequence and iDRAC is still 
booting.

NOTE: When MX750c is installed in MX7000, the power button LED indicator display the status as off for one minute while 

the sled is initialized, even if the sled is configured to power on automatically (for example, with an AC power recovery 

policy of, On or Last). After one minute, if the sled is configured to power on automatically, the power button LED will start 

slowly blinking to indicate the system is performing the powering on sequence.

Status LED indicators

NOTE: The indicators display solid amber if any error occurs.

3
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Figure 3. Status LED indicators

Figure 4. Status LED indicators

Table 10. Status LED indicators and descriptions 

Icon Description Condition Corrective action

Drive indicator The indicator turns solid amber if 
there is a drive error.

● Check the System Event Log to determine if the 
drive has an error.

● Run the appropriate Online Diagnostics test. 
Restart the system and run embedded 
diagnostics (ePSA).

● If the drives are configured in a RAID array, 
restart the system, and enter the host adapter 
configuration utility program.

Temperature 
indicator

The indicator turns solid amber if 
the system experiences a thermal 
error (for example, the ambient 
temperature is out of range or 
there is a fan failure).

Ensure that none of the following conditions exist:
● A cooling fan has been removed or has failed.
● System cover, air shrouds, or back filler bracket 

has been removed.
● Ambient temperature is too high.
● External airflow is obstructed.
If the problem persists, see the Getting help section. 

Electrical 
indicator

The indicator turns solid amber 
if the system experiences an 
electrical error (for example, 
voltage out of range, or a failed 
power supply unit (PSU) or voltage 
regulator).

Check the System Event Log or system messages 
for the specific issue. If it is due to a problem with 
the PSU, check the LED on the PSU. Reseat the 
PSU.

If the problem persists, see the
Getting help section.

Memory indicator The indicator turns solid amber if a 
memory error occurs.

Check the System Event Log or system messages 
for the location of the failed memory. Reseat the 
memory module.

If the problem persists, see the
Getting help section.

PCIe indicator The indicator turns solid amber if a 
PCIe card experiences an error.

Restart the system. Update any required drivers for 
the PCIe card. Reinstall the card.

If the problem persists, see the
Getting help section.
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Table 10. Status LED indicators and descriptions (continued)

Icon Description Condition Corrective action

NOTE: For more information about the 
supported PCIe cards, see the Expansion card 
installation guidelines section.

System health and system ID indicator codes

The system health and system ID indicator is located on the left control panel of the system.The system health and system ID 
indicator is located towards the left control panel of the system for Rear Accessed configuration and towards the right control 
panel of the system for Front Accessed configuration.The system health and system ID indicator is located on the Status LED 
Control Panel of the system for Rear and Front Accessed configurations. The system health and system ID indicator is located 
on the front panel of the system.

Figure 5. System health and system ID indicator

Figure 6. System health and system ID indicator

Figure 7. System health and system ID indicator
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Figure 8. System health and system ID indicators

Table 11. System health and system ID indicator codes 

System health and system ID 
indicator code

Condition

Solid blue Indicates that the system is powered on, is healthy, and system ID mode is not active. 
Press the system health and system ID button to switch to system ID mode.

Blinking blue Indicates that the system ID mode is active. Press the system health and system ID 
button to switch to system health mode.

Solid amber Indicates that the system is in fail-safe mode. If the problem persists, see the Getting 
help section. 

Blinking amber Indicates that the system is experiencing a fault. Check the System Event Log 
for specific error messages. For information about the event and error messages 
generated by the system firmware and agents that monitor system components, go 
to QRL > Look Up > Error Code, type the error code, and then click Look it up.

iDRAC Quick Sync 2 indicator codes

iDRAC Quick Sync 2 module (optional) is located on the left control panelfront IO panel of the system.

Table 12. iDRAC Quick Sync 2 indicators and descriptions 

iDRAC Quick Sync 2 indicator 
code

Condition Corrective action

Off (default state) Indicates that the iDRAC Quick Sync 2 
feature is powered off. Press the iDRAC 
Quick Sync 2 button to power on the 
iDRAC Quick Sync 2 feature.

If the LED fails to power on, reseat the left 
control panel flexfront IO panel cable and check. 
If the problem persists, see the Getting help 
section.

Solid white Indicates that iDRAC Quick Sync 2 is 
ready to communicate. Press the iDRAC 
Quick Sync 2 button to power off.

If the LED fails to power off, restart the system. 
If the problem persists, see the Getting help 
section.

Blinks white rapidly Indicates data transfer activity. NA

If the indicator continues to blink indefinitely, see 
the
Getting help section.

Blinks white slowly Indicates that firmware update is in 
progress.

NA

If the indicator continues to blink indefinitely, see 
the
Getting help section.

Blinks white five times rapidly 
and then powers off

Indicates that the iDRAC Quick Sync 2 
feature is disabled.

Check if iDRAC Quick Sync 2 feature is 
configured to be disabled by iDRAC. If the 
problem persists, see the Getting help section. 
PowerEdge manuals or Dell OpenManage Server 
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Table 12. iDRAC Quick Sync 2 indicators and descriptions (continued)

iDRAC Quick Sync 2 indicator 
code

Condition Corrective action

Administrator User’s Guide at OpenManage 
Manuals.

Solid amber Indicates that the system is in fail-safe 
mode.

Restart the system. If the problem persists, see 
the Getting help section.

Blinking amber Indicates that the iDRAC Quick Sync 2 
hardware is not responding properly.

Restart the system. If the problem persists, see 
the Getting help section.

Table 13. iDRAC Quick Sync 2 indicators and descriptions 

iDRAC Quick Sync 2 indicator 
code

Condition Corrective action

Off (default state) Indicates that the iDRAC Quick Sync 2 
feature is powered off. Press the iDRAC 
Quick Sync 2 button to power on the 
iDRAC Quick Sync 2 feature.

If the LED fails to power on, reseat the left 
control panel flexfront IO panel cable and check. 
If the problem persists, see the Getting help 
section.

Solid white Indicates that iDRAC Quick Sync 2 is 
ready to communicate. Press the iDRAC 
Quick Sync 2 button to power off.

If the LED fails to power off, restart the system. 
If the problem persists, see the Getting help 
section.

Blinks white rapidly Indicates data transfer activity. NA

If the indicator continues to blink indefinitely, see 
the
Getting help section.

Blinks white slowly Indicates that firmware update is in 
progress.

NA

If the indicator continues to blink indefinitely, see 
the
Getting help section.

Blinks white five times rapidly 
and then powers off

Indicates that the iDRAC Quick Sync 2 
feature is disabled.

Check if iDRAC Quick Sync 2 feature is 
configured to be disabled by iDRAC. If the 
problem persists, see the Getting help section. 
PowerEdge manuals or Dell OpenManage Server 
Administrator User’s Guide at OpenManage 
Manuals.

Solid amber Indicates that the system is in fail-safe 
mode.

Restart the system. If the problem persists, see 
the Getting help section.

Blinking amber Indicates that the iDRAC Quick Sync 2 
hardware is not responding properly.

Restart the system. If the problem persists, see 
the Getting help section.

iDRAC Direct LED indicator codes

The iDRAC Direct LED indicator lights up to indicate that the port is connected and is being used as a part of the iDRAC 
subsystem.

You can configure iDRAC Direct by using a USB to micro USB (type AB) cable, which you can connect to your laptop or 
tablet. Cable length should not exceed 3 feet (0.91 meters). Performance could be affected by cable quality. The following table 
describes iDRAC Direct activity when the iDRAC Direct port is active:
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Table 14. iDRAC Direct LED indicator codes 

iDRAC Direct LED 
indicator code

Condition

Solid green for two 
seconds

Indicates that the laptop or tablet is connected.

Blinking green (on for 
two seconds and off for 
two seconds) 

Indicates that the laptop or tablet connected is recognized.

LED Indicator off Indicates that the laptop or tablet is unplugged.

LCD panel

The LCD panel provides system information, status, and error messages to indicate if the system is functioning correctly or 
requires attention. The LCD panel is used to configure or view the iDRAC IP address of the system. For information about the 
event and error messages generated by the system firmware and agents that monitor system components, go to QRL > Look 
Up > Error Code, type the error code, and then click Look it up..

The LCD panel is available only on the optional front bezel. The optional front bezel is hot pluggable.

The status and conditions of the LCD panel are outlined here:

● The LCD backlight is white during normal operating conditions.
● If there is an issue, the LCD backlight turns amber and displays an error code followed by descriptive text.

NOTE: If the system is connected to a power source and an error is detected, the LCD turns amber regardless of 

whether the system is powered on or off.

● When the system powers off and there are no errors, the LCD enters the standby mode after five minutes of inactivity. 
Press any button on the LCD to power it on.

● If the LCD panel stops responding, remove the bezel and reinstall it.

If the problem persists, see Getting help.
● The LCD backlight remains off if LCD messaging is powered off using the iDRAC utility, the LCD panel, or other tools.

Figure 9. LCD panel features

Table 15. LCD panel features 

Item Button or 
display

Description

1 Left Moves the cursor back in one-step increments.

2 Select Selects the menu item highlighted by the cursor.

3 Right Moves the cursor forward in one-step increments.

During message scrolling:

● Press and hold the right button to increase scrolling speed.
● Release the button to stop.

NOTE: The display stops scrolling when the button is released. After 45 seconds of inactivity, 
the display starts scrolling.

4 LCD display Displays the system information, status, and error messages or iDRAC IP address.
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Viewing Home screen

The Home screen displays user-configurable information about the system. This screen is displayed during normal system 
operation when there are no status messages or errors. When the system turns off and there are no errors, LCD enters the 
standby mode after five minutes of inactivity. Press any button on the LCD to turn it on.

Steps

1. To view the Home screen, press one of the three navigation buttons (Select, Left, or Right).

2. To navigate to the Home screen from another menu, complete the following steps:

a. Press and hold the navigation button till the up arrow  is displayed.

b. Navigate to the Home icon  using the up arrow .
c. Select the Home icon.
d. On the Home screen, press the Select button to enter the main menu.

Setup menu

NOTE: When you select an option in the Setup menu, you must confirm the option before proceeding to the next action.

Table 16. Setup menu 

Option Description

iDRAC Select DHCP or Static IP to configure the network mode. If Static IP is selected, the available fields 
are IP, Subnet (Sub), and Gateway (Gtw). Select Setup DNS to enable DNS and to view domain 
addresses. Two separate DNS entries are available.

Set error Select SEL to view LCD error messages in a format that matches the IPMI description in the SEL. This 
enables you to match an LCD message with an SEL entry. Select Simple to view LCD error messages in a 
simplified user-friendly description. For information about the event and error messages generated by the 
system firmware and agents that monitor system components, go to QRL > Look Up > Error Code, type 
the error code, and then click Look it up..

Set home Select the default information to be displayed on the Home screen. See View menu section for the options 
and option items that can be set as the default on the Home screen.

View menu

NOTE: When you select an option in the View menu, you must confirm the option before proceeding to the next action.

Table 17. View menu 

Option Description

iDRAC IP Displays the IPv4 or IPv6 addresses for iDRAC9. Addresses include DNS (Primary and 
Secondary), Gateway, IP, and Subnet (IPv6 does not have Subnet).

MAC Displays the MAC addresses for iDRAC, iSCSI, or Network devices.

Name Displays the name of the Host, Model, or User String for the system.

Number Displays the Asset tag or the Service tag for the system.

Power Displays the power output of the system in BTU/hr or Watts. The display format can be 
configured in the Set home submenu of the Setup menu.

Temperature Displays the temperature of the system in Celsius or Fahrenheit. The display format can 
be configured in the Set home submenu of the Setup menu.
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NIC indicator codes

Each NIC on the back of the system has indicators that provide information about the activity and link status. The activity LED 
indicator indicates if data is flowing through the NIC, and the link LED indicator indicates the speed of the connected network.

Figure 10. NIC indicator codes

1. Link LED indicator
2. Activity LED indicator

Table 18. NIC indicator codes 

NIC indicator codes Condition

Link and activity indicators are off. Indicates that the NIC is not connected to the network.

Link indicator is green, and activity indicator is blinking 
green.

Indicates that the NIC is connected to a valid network at its maximum 
port speed, and data is being sent or received.

Link indicator is amber, and activity indicator is blinking 
green.

Indicates that the NIC is connected to a valid network at less than its 
maximum port speed, and data is being sent or received.

Link indicator is green, and activity indicator is off. Indicates that the NIC is connected to a valid network at its maximum 
port speed, and data is not being sent or received.

Link indicator is amber, and activity indicator is off. Indicates that the NIC is connected to a valid network at less than its 
maximum port speed, and data is not being sent or received.

Link indicator is blinking green, and activity is off. Indicates that the NIC identity is enabled through the NIC 
configuration utility.

Power supply unit indicator codes

AC and DC power supply units (PSUs) have an illuminated translucent handle that serves as an indicator. The indicator shows if 
power is present or if a power fault has occurred.

Figure 11. Rear Accessed configuration - AC PSU status indicator

1. AC PSU handle
2. Socket
3. Release latch
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Figure 12. Front Accessed configuration - AC PSU status indicator

1. AC PSU handle
2. Socket
3. Release latch

Table 19. AC and DC PSU status indicator codes 

Power indicator codes Condition

Green Indicates that a valid power source is connected to the PSU 
and the PSU is operational.

Blinking amber Indicates an issue with the PSU.

Not powered on Indicates that the power is not connected to the PSU.

Blinking green Indicates that the firmware of the PSU is being updated.
CAUTION: Do not disconnect the power cord or 
unplug the PSU when updating firmware. If firmware 
update is interrupted, the PSUs will not function.

Blinking green and powers off When hot-plugging a PSU, it blinks green five times at a rate 
of 4 Hz and powers off. This indicates a PSU mismatch due to 
efficiency, feature set, health status, or supported voltage.

CAUTION: If two PSUs are installed, both the PSUs 
must have the same type of label; for example, 
Extended Power Performance (EPP) label. Mixing 
PSUs from previous generations of PowerEdge 
servers is not supported, even if the PSUs have the 
same power rating. This results in a PSU mismatch 
condition or failure to power on the system.

CAUTION: If two PSUs are used, they must be of 
the same type and have the same maximum output 
power.

CAUTION: When correcting a PSU mismatch, replace 
the PSU with the blinking indicator. Swapping the 
PSU to make a matched pair can result in an error 
condition and an unexpected system shutdown. To 
change from a high output configuration to a low 
output configuration or vice versa, you must power 
off the system.

CAUTION: When two identical PSUs receive different 
input voltages, they can output different wattage, 
and trigger a mismatch.

For example a 1100W PSU connected to a High-Line AC 
(HLAC) 200Vac-240Vac input, it will output 1100W. But if a 
second 1100W PSU in the same system is connected to a Low 
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Table 19. AC and DC PSU status indicator codes (continued)

Power indicator codes Condition

Line 100-120Vac input, it will only output 1050W, triggering a 
mismatch.

NOTE: Mixed Mode PSUs support both AC and DC voltages. AC voltages range from 100Vac to 240Vac, unless the PSU is 

High-Line AC (HLAC), in that case the AC voltage range is 200Vac to 240Vac. The DC voltage is 240Vdc on all Mixed Mode 

PSUs.

Table 20. DC PSU status indicator codes 

Power indicator codes Condition

Green Indicates that a valid power source is connected to the PSU, 
and the PSU is operational.

Blinking amber Indicates an issue with the PSU.

Not powered on Indicates that the power is not connected to the PSU.

Blinking green When hot-plugging a PSU, it blinks green five times at a rate 
of 4 Hz and powers off. This indicates a PSU mismatch due to 
efficiency, feature set, health status, or supported voltage.

CAUTION: If two PSUs are installed, both the PSUs 
must have the same type of label; for example, 
Extended Power Performance (EPP) label. Mixing 
PSUs from previous generations of PowerEdge 
servers is not supported, even if the PSUs have the 
same power rating. This results in a PSU mismatch 
condition, or failure to power on the system.

CAUTION: If two PSUs are used, they must be of 
the same type and have the same maximum output 
power.

CAUTION: When correcting a PSU mismatch, replace 
the PSU with the blinking indicator. Swapping the 
PSU to make a matched pair can result in an error 
condition and an unexpected system shutdown. To 
change from a High Output configuration to a Low 
Output configuration or conversely, you must power 
off the system.

CAUTION: Combining AC and DC PSUs is not 
supported.

Non-redundant cabled power supply unit indicator codes

Press the self-diagnostic button to perform a quick health check on the non-redundant cabled power supply unit (PSU) of the 
system.
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Figure 13. Non-redundant cabled AC PSU status indicator and self-diagnostic button

1. Self-diagnostic button
2. AC PSU status indicator

Table 21. Non-redundant AC PSU status indicator 

Power Indicator Pattern Condition

Not lit Power is not connected or PSU is faulty.

Green A valid power source is connected to the PSU and the PSU is operational.
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Drive indicator codes

The LEDs on the drive carrier indicate the state of each drive. Each drive carrier has two LEDs: an activity LED (green) and a 
status LED (bicolor, green/amber). The activity LED blinks whenever the drive is accessed.

Figure 14. Drive indicators on the drive and the mid drive tray backplane

1. Drive activity LED indicator
2. Drive status LED indicator
3. Drive capacity label

Figure 15. Drive indicators

1. Drive activity LED indicator
2. Drive status LED indicator
3. Drive capacity label

NOTE: If the drive is in the Advanced Host Controller Interface (AHCI) mode, the status LED indicator does not power on.

NOTE: Drive status indicator behavior is managed by Storage Spaces Direct. Not all drive status indicators may be used.

Table 22. Drive indicator codes 

Drive status indicator code Condition

Blinks green twice per second Indicates that the drive is being identified or preparing for removal.

Off Indicates that the drive is ready for removal.
NOTE: The drive status indicator remains off until all drives are 
initialized after the system is powered on. Drives are not ready 
for removal during this time.

Blinks green, amber, and then powers off Indicates that there is an unexpected drive failure.

Blinks amber four times per second Indicates that the drive has failed.

Blinks green slowly Indicates that the drive is rebuilding.

Solid green Indicates that the drive is online.
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Table 22. Drive indicator codes (continued)

Drive status indicator code Condition

Blinks green for three seconds, amber for three seconds, 
and then powers off after six seconds

Indicates that the rebuild has stopped.

Using system diagnostics

If you experience an issue with the system, run the system diagnostics before contacting Dell Technologies for technical 
assistance. The purpose of running system diagnostics is to test the system hardware without using additional equipment or 
risking data loss. If you are unable to fix the issue yourself, service and support personnel can use the diagnostics results to help 
you solve the issue.

Dell Embedded System Diagnostics

NOTE: The Dell Embedded System Diagnostics is also known as Enhanced Pre-boot System Assessment (ePSA) 

diagnostics.

The Embedded System Diagnostics provide a set of options for particular device groups or devices allowing you to:
● Run tests automatically or in an interactive mode
● Repeat tests
● Display or save test results
● Run thorough tests to introduce additional test options to provide extra information about the failed device(s)
● View status messages that inform you if tests are completed successfully
● View error messages that inform you of issues encountered during testing

Running the Embedded System Diagnostics from the Dell Lifecycle Controller

Steps

1. When the system is booting, press F10.

2. Select Hardware Diagnostics → Run Hardware Diagnostics.
The ePSA Pre-boot System Assessment window is displayed, listing all devices detected in the system. The diagnostics 
start executing the tests on all the detected devices.

Running the Embedded System Diagnostics from Boot Manager

Run the Embedded System Diagnostics (ePSA) if your system does not boot.

Steps

1. When the system is booting, press F11.

2. Use the up arrow and down arrow keys to select System Utilities > Launch Diagnostics.

3. Alternatively, when the system is booting, press F10, select Hardware Diagnostics > Run Hardware Diagnostics.
The ePSA Pre-boot System Assessment window is displayed, listing all devices detected in the system. The diagnostics 
starts executing the tests on all the detected devices.

System diagnostic controls

Table 23. System diagnostic controls 

Menu Description

Configuration Displays the configuration and status information of all 
detected devices.

Results Displays the results of all tests that are run.
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Table 23. System diagnostic controls (continued)

Menu Description

System health Provides the current overview of the system performance.

Event log Displays a time-stamped log of the results of all tests run on 
the system. This is displayed if at least one event description 
is recorded.

System board diagnostic LED indicators

The system board LED indicators provide status of the system when it is powered on, which help identify POST and hardware 
issues.

For information about the different LED indicator sequences and description, see the interactive LED pattern decoder tool 
-Blink

Table 24. LED status 

LED Status

○ LED Off

● LED on

B Blinking LED

*

LED Off : PFAULT

LED Blink : FAILSAFE Timeout

LED On : FAILSAFE Strike Out

Table 25. Power-up LED sequence 

Power-Up Sequence

LED7 LED6 LED5 LED4 LED3 LED2 LED1 Description

○ ○ ○ ○ ○ ○ ● 2.5V_AUX EN. Waiting for 2.5V_AUX PG

○ ○ ○ ○ ○ ● ○ 1.8V_AUX EN. Waiting for 1.8V_AUX PG

○ ○ ○ ○ ○ ● ● 5V SW EN. CKMNG EN. Waiting for 5V SW PG

○ ○ ○ ○ ● ○ ○ V_PVNN EN. Waiting for V_PVNN PG

○ ○ ○ ○ ● ○ ● 1.05V SW EN. Waiting for 1.05V SW PG

○ ○ ○ ○ ● ● ○ V_VSBM EN. Waiting for V_VSBM PG

○ ○ ○ ○ ● ● ● V_VSB11 EN. Waiting for V_VSB11 PG

○ ○ ○ ● ○ ○ ● Waiting for PCH_SLP_SUS_N. PCH_RSMRST_N still asserted

○ ○ ○ ● ○ ● ○ Config check. Waiting for BMC to boot. PCH_RSMRST_N de-asserted

○ ○ ○ ● ○ ● ● Waiting for PWR button

○ ○ ○ ● ● ○ ○ 12V EN. Waiting for PSU* PG

○ ○ ○ ● ● ● ● 3.3V_AB EN. Waiting for 3.3V A+B PG

○ ○ ● ○ ○ ○ ○ BP VRs EN. Waiting for BP* PG

○ ○ ● ○ ○ ○ ● MEM VPP EN. Waiting for MEM VPP PGs

○ ○ ● ○ ○ ● ○ MEM VDDQ EN. Waiting for MEM VDDQ PGs

○ ○ ● ○ ○ ● ● MEM VTT EN. Waiting for MEM VTT PGs

○ ○ ● ○ ● ○ ○ CPU* VCCIO and PCIe clocks EN. Waiting for CPU VCCIO PGs
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Table 25. Power-up LED sequence (continued)

Power-Up Sequence

○ ○ ● ○ ● ○ ● CPU* VCORE/VSA EN. Waiting for CPU* VCORE+VSA PGs

○ ○ ● ○ ● ● ○ Waiting for NDC PG

○ ○ ● ○ ● ● ● Waiting for PCH PROCPWRGD

○ ○ ● ● ○ ○ ○ CPU* PG Asserted. SYS PWRGOOD Asserted

● ● ● ● ● ● ● RUN State

○ ○ ● ● ○ ● ○ PLTRST_N Asserted

○ ○ ● ● ○ ● ● CPU & MEM VR’s Shutdown

○ ○ ● ● ● ○ ○ MAIN Rails Shutdown (7 seconds)

Table 26. NvDIMM LED sequence 

NvDIMM

LED7 LED6 LED5 LED4 LED3 LED2 LED1 Description

● ● ● ● ● ● ● RUN State – System operating normally

● ○ ○ ○ ● ○ ○ System powered down, NVsave in progress

● ○ ○ ● ● ○ ● NVsave complete. Asserting EMMC_PWROFF_NOTIFY_N to BMC

○ ○ ○ ○ ○ ○ ○ V_12V_SW powered down. System in G3, waiting for AC power

Table 27. System board LED sequence 

Error

LED7 LED6 LED5 LED4 LED3 LED2 LED1 Description

B ○ ○ ○ ○ ○ B Config Error: CPU1 present? DIMMs OK? Install DBG JMPR1 to bypass

B B ○ ○ ○ B B CPU IERR

○ ● ● ● ● ● ○ CPU COMBINED MCERR

B B B B B B B Thermal Issue on CPU* or MEM

B ○ B B B ○ B Internal VR Issue on CPU*

B ○ ○ ● ○ ○ B AUX Power Failsafe

Table 28. Pfault or failsafe errors LED sequence 

Pfault or Failsafe Errors

LED7 LED6 LED5 LED4 LED3 LED2 LED1 Description

* B ○ ○ ○ ○ ○ 12V Failure

* B ○ ○ ○ ○ ● 5V BP0 Failure

* B ○ ○ ○ ● ○ 5V BP1 Failure

* B ○ ○ ○ ● ● 5V BP2 Failure

* B ○ ○ ● ○ ○ 3.3V A Failure

* B ○ ○ ● ○ ● 3.3V B Failure

* B ○ ○ ● ● ○ 5V SW Failure

* B ○ ○ ● ● ● 1.05V SW Failure

* B ○ ● ○ ○ ○ CPU1 VCORE Failure
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Table 28. Pfault or failsafe errors LED sequence (continued)

Pfault or Failsafe Errors

* B ○ ● ○ ○ ● CPU2 VCORE Failure

* B ○ ● ○ ● ○ CPU1 VCCIO Failure

* B ○ ● ○ ● ● CPU2 VCCIO Failure

* B ○ ● ● ○ ○ CPU1 VSA Failure

* B ○ ● ● ○ ● CPU2 VSA Failure

* B ○ ● ● ● ○ CPU1 MEM012 VTT Failure

* B ○ ● ● ● ● CPU1 MEM345 VTT Failure

* B ● ● ○ ○ ○ CPU2 MEM012 VTT Failure

* B ● ○ ○ ○ ● CPU2 MEM345 VTT Failure

* B ● ○ ○ ● ○ CPU1 MEM012 VPP Failure

* B ● ○ ○ ● ● CPU1 MEM345 VPP Failure

* B ● ○ ● ○ ○ CPU2 MEM012 VPP Failure

* B ● ○ ● ○ ● CPU2 MEM345 VPP Failure

* B ● ○ ● ● ○ CPU1 MEM012 VDDQ Failure

* B ● ○ ● ● ● CPU1 MEM345 VDDQ Failure

* B ● ○ ○ ○ ○ CPU2 MEM012 VDDQ Failure

* B ● ● ○ ○ ● CPU2 MEM345 VDDQ Failure

* B ● ● ○ ● ○ V_PVNN SW Failure

* B ● ● ○ ● ● 1.8V SW Failure

* B ● ● ● ○ ○ V_VSB11 SW Failure

* B ● ● ● ○ ● V_VSBM SW Failure

* B ● ● ● ● ○ NDC Failure

* B ● ● ● ● ● 2.5V SW Failure

Enhanced Preboot System Assessment
If you experience an issue with the system, run the system diagnostics before contacting Dell for technical assistance. The 
purpose of running system diagnostics is to test the system hardware without requiring more equipment or risking data loss. 
If you are unable to fix the issue yourself, service and support personnel can use the diagnostics results to help you solve the 
issue.

Dell Embedded system diagnostics

NOTE: The Dell Embedded System Diagnostics is also known as Enhanced Preboot System Assessment (ePSA) diagnostics.

The embedded system diagnostics provides a set of options for particular device groups or devices that allow you to:

● Run tests automatically or in an interactive mode.
● Repeat tests
● Display or save test results.
● Introduce more test options for extra information about the failed devices, run a thorough test.
● View status messages that inform you if tests are completed successfully.
● View error messages that inform you of issues encountered during testing.
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Running the Embedded system diagnostics from Boot Manager

To run the embedded system diagnostics from Boot Manager:

1. As the system boots, press <F11>.

2. Using the arrow keys select System Utilities → Launch Diagnostics.

3. Wait while the Quick Tests automatically run.
4. Once the tests have been completed, you can view the results and additional information on the Results tab, the System 

Health tab, the Configuration tab, and the Event Log tab.
5. Close the Embedded System Diagnostics utility.
6. To leave the diagnostics, click Exit.
7. Click OK when prompted, and the system reboots.

Running the Embedded System Diagnostics from the Dell Lifecycle 
Controller

To run the embedded system diagnostics from the Dell Lifecycle Controller:

1. As the system boots, press F10.
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2. Select Hardware Diagnostics → Run Hardware Diagnostics.

SupportAssist Enterprise

After July 2022, SupportAssist Enterprise 2.x capabilities such as device management, case creation, and alert monitoring will be 
discontinued. To continue to manage and monitor your devices, you must upgrade to Secure Connect Gateway.

Secure Connect Gateway

Secure Connect Gateway is an enterprise monitoring technology that is delivered as an appliance and a stand-alone application. 
It monitors your devices and proactively detects issues that may occur. Depending on your service contract, it also automates 
support request creation for issues that are detected on the monitored devices. Supported products include Dell servers, data 
storage, chassis, networking, data protection devices, virtual machines, and converged or hyperconverged appliances.

Upgrading from SupportAssist Enterprise to Secure Connect Gateway.

Frequently asked questions

The frequently asked questions (FAQs) for the some of the server components are listed below.

Table 29. FAQs for drives 

Issue Resolution

How to identify a physical disk failure? To identify a physical disk failure and diagnose, see link.

How to check if there are any issues with your drive? To identify the issues with your drive, see link.

What are the different steps to diagnose issues with your 
drive?

To identify the diagnostic options, see link.

What are the different RAID and drive error messages related 
to servers?

The check on the different RAID and drive error messages for 
servers, see link .

What do we do when a SMART error occurs on a physical disk 
that is part of a virtual disk?

To resolve issues when SMART error occurs on a physical disk 
that is part of a virtual disk, see link .

Table 30. FAQs for processors 

Issue Resolution

What is the meaning of CPU 1 has an internal error (IERR)? To identify the CPU IERR error in system event logs and 
resolve it, see link .

How to view error messages in System Event logs? For information about SEL, see link .
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Table 31. FAQs for PERC 

Issue Resolution

How to fix PowerEdge RAID Controller Errors? PERC errors can happen due to various causes, see link.

What is preserved cache in PERC? For information about preserved cache, see link .

How do we manage preserved cache? For information about how to manage preserved cache, see 
link .

How does auto replace work on PERC? For information about how auto replace works on PERC, see 
link.

Table 32. FAQs for memory 

Issue Resolution

What is DDR4 Self-healing on Dell PowerEdge Servers with 
Intel Xeon Scalable Processors?

For information about DDR4 self-healing, see link.

Does out of date firmware cause memory errors? Out dated firmware can be a cause for memory errors, for 
information see link for RAID Controller 9 User's Guide and 
see link for RAID Controller 10 User's Guide.

I need more information about memory error handling for Dell 
servers. Where do I find it?

For information about memory error handling strategy for 
PowerEdge platforms, see link.

Table 33. FAQs for NIC 

Issue Resolution

How to set up NIC teaming on PowerEdge Servers? For more information, see link.

How to configure the iDRAC9 and the Lifecycle Controller 
Network IP?

For more information, see link.

Videos

There are videos available for PowerEdge servers that capture removing or installing steps for the components.

To watch remove or install videos, follow the steps that are mentioned below:
1. Go to QRL.
2. Enter your product name in the Search bar and press enter.
3. Click on the product name that is listed in the search result, and watch the video for more information.

Troubleshooting hardware issues

This section helps you troubleshoot hardware issues in your system.

NOTE: If the issue still persists, contact Dell Technologies Technical Support for assistance.

Troubleshooting system startup failure

If you boot the system to the BIOS boot mode after installing an operating system from the UEFI Boot Manager, the system 
stops responding. To avoid this issue, you must boot to the same boot mode in which you installed the operating system.

For no boot device available issue during system startup refers: No boot device found article.
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Troubleshooting the video subsystem

Prerequisites

NOTE: Ensure that the Local Server Video Enabled option is selected in the iDRAC Graphical User Interface (GUI), under 

Virtual Console. If this option is not selected, local video is disabled.

NOTE: The VGA ports are not hot-pluggable.

Steps

1. Check the cable connections (power and display) to the monitor.

2. Check the video interface cabling from the system to the monitor.

3. Run the LCD Built-in Self Test (BIST).

Results

If the tests run successfully, the problem is not related to video hardware.

For more information on no video, refer the No Video section in the article.

Next steps

If the tests fail, see the Get help section.

Troubleshooting a USB device

Steps

1. Disconnect the keyboard and/or mouse cables from the system and reconnect them.

2. If the problem persists, connect the keyboard and/or mouse to another USB port on the system.

3. If the problem is resolved, restart the system, enter System Setup, and check if the non-functioning USB ports are enabled.

NOTE: Older operating systems may not support USB 3.0.

4. Check if USB 3.0 is enabled in System Setup. If enabled, disable it and see if the issue is resolved.

5. In iDRAC Settings Utility, ensure that USB Management Port Mode is configured as Automatic or Standard OS Use.

6. If the problem is not resolved, replace the keyboard and/or mouse with a known working keyboard or mouse.

If the problem is not resolved, proceed to next step to troubleshoot other USB devices attached to the system.

7. Turn off all attached USB devices, and disconnect them from the system.

8. Restart the system.

9. If your keyboard is functioning, enter System Setup, verify that all USB ports are enabled on the Integrated Devices 
screen. If your keyboard is not functioning, use remote access to enable or disable the USB options.

10. Check if USB 3.0 is enabled in System Setup. If it is enabled, disable it and restart your system.

11. If the system is not accessible, reset the NVRAM_CLR jumper inside your system and restore the BIOS to the default 
settings. See the System board jumper setting section

12. In the IDRAC Settings Utility, ensure that USB Management Port Mode is configured as Automatic or Standard OS 
Use.

13. Reconnect and turn on each USB device one at a time.

14. If a USB device causes the same problem, turn off the device, replace the USB cable with a known good cable, and turn on 
the device.

Next steps

If all troubleshooting fails, see the Get help section.

For more information, see USB devices not recognized.
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Troubleshooting a serial Input Output device

Prerequisites

NOTE: The Serial port is not hot-pluggable.

Steps

1. Turn off the system and any peripheral devices that are connected to the serial port.

2. Swap the serial interface cable with a known working cable, and turn on the system and the serial device.

If the problem is resolved, replace the interface cable with a known working cable.

3. Turn off the system and the serial device, and swap the serial device with a compatible device.

4. Turn on the system and the serial device.

Next steps

If the problem persists, see the Get help section.

Troubleshooting external connections

Before troubleshooting any external devices, ensure that all external cables are securely attached to the external connectors on 
your system.

● Compare the technical specification of the system with the external device to check the compatibility.
● Check the external device functionality with some other similar system so that we are sure that the device is working fine.
● Check any other similar external device with this system so that we are sure that the system port is working fine.

For any further queries contact, Contact Technical Support.

Troubleshooting a tape backup unit

Prerequisites

CAUTION: Many repairs may only be done by a certified service technician. You should only perform 

troubleshooting and simple repairs as authorized in your product documentation, or as directed by the online or 

telephone service and support team. Damage due to servicing that is not authorized by Dell is not covered by 

your warranty. Read and follow the safety instructions that are shipped with your product.

Steps

1. Use a different tape cartridge.

2. Ensure that the device drivers for the tape backup unit are installed and are configured correctly. See your tape drive 
documentation for more information about device drivers.

3. Reinstall the tape-backup software as instructed in the tape-backup software documentation.

4. Ensure that the interface cable of the tape drive is connected to the external port on the controller card.

5. Perform the following steps to ensure that the controller card is properly installed:

a. Turn off the system and attached peripherals, and disconnect the system from the electrical outlet.
b. Remove the system cover.
c. Reseat the controller card in the expansion card slot.
d. Install the system cover.
e. Turn on the system and attached peripherals.

6. Run the appropriate diagnostic test. For more information, see the Using system diagnostics.

Next steps

If you cannot resolve the problem, see the Getting help section.
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Troubleshooting a NIC

Prerequisites

NOTE: Network Daughter Card (NDC) slot is not hot-pluggable.

Steps

1. Run the appropriate diagnostic test. For more information, see the system diagnostics section for the available diagnostic 
tests.

2. Restart the system and check for any system messages pertaining to the NIC controller.

3. Check the appropriate indicator on the NIC connector:

● If the link indicator does not glow, the cable connected might be disengaged.
● If the activity indicator does not glow, the network driver files might be damaged or missing. Install or replace the drivers 

as necessary. For more information, see the NIC documentation.
● Try another known good network cable.
● If the problem persists, use another connector on the switch or hub.

4. Ensure that the appropriate drivers are installed and the protocols are bound. For more information, see the NIC 
documentation or for issue related to network port How to troubleshoot network port access.

5. Enter System Setup and confirm that the NIC ports are enabled on the Integrated Devices screen.

6. Ensure that all the NICs, hubs, and switches on the network are set to the same data transmission speed and duplex. For 
more information, see the documentation for each network device.

7. Ensure that all the NICs and switches on the network are set to the same data transmission speed and duplex. For more 
information, see the documentation for each network device.

8. Ensure that all network cables are of the proper type and do not exceed the maximum length.

Next steps

If the problem persists, see the Get help section.

For information on NIC teaming, see How to set up NIC teaming on PowerEdge Servers.

Troubleshooting a wet system

Steps

1. Turn off the system and attached peripherals, and disconnect the system from the electrical outlet.

2. Remove the system cover.

3. Remove the following components (if installed) from the system:

● Power supply unit(s)
● Optical drive
● Hard drives
● Hard drive backplane
● USB memory key
● Hard drive tray
● Cooling shroud
● Expansion card risers (if installed)
● Expansion cards
● Cooling fan assembly (if installed)
● Cooling fan(s)
● Memory modules
● Processor(s) and heat sink(s)
● Processor and heat sink module
● System board
● Mezzanine card
● Power distribution boards
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● Midplanes

4. Let the system dry thoroughly for at least 24 hours.

5. Reinstall the components you removed in step 3 except the expansion cards.

6. Install the system cover.

7. Turn on the system and attached peripherals.

If the problem persists, see the Getting help section.

8. If the system starts properly, turn off the system, and reinstall all the expansion cards that you removed.

9. Run the appropriate diagnostic test. For more information, see the Using system diagnostics section.

Next steps

If the tests fail, see the Getting help section.

Troubleshooting a damaged system

Steps

1. Turn off the system and attached peripherals, and disconnect the system from the electrical outlet.

2. Remove the system cover.

3. Ensure that the following components are properly installed:

● cooling shroud
● expansion card risers (if installed)
● expansion cards
● power supply unit(s)
● cooling fan assembly (if installed)
● cooling fan(s)
● processor(s) and heat sink(s)
● memory modules
● drive carriers or cage
● drive backplane

4. Ensure that all cables are properly connected.

5. Install the system cover.

6. Run the appropriate diagnostic test. For more information, see the Using system diagnostics section.

Next steps

If the problem persists, see the Getting help section.

Troubleshooting the system battery

Prerequisites

NOTE: If the system is turned off for long periods of time (for weeks or months), the NVRAM may lose the system 

configuration information. This situation is caused by a defective battery.

NOTE: Some software may cause the system time to speed up or slow down. If the system seems to operate normally 

except for the time set in System Setup, the problem may be caused by a software, rather than by a defective battery.

Steps

1. Re-enter the time and date in System Setup.

2. Turn off the system, and disconnect it from the electrical outlet for at least an hour.

3. Reconnect the system to the electrical outlet, and turn on the system.

4. Enter System Setup.
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If the date and time displayed in System Setup are not correct, check the System Error Log (SEL) for system battery 
messages.

Next steps

If the problem persists, see the Getting help section.

Dell cooling problems

The fans are running at a higher speed than expected.

Prerequisites

NOTE: The fan number is referenced by the management software of the system. In the event of a problem with a 

particular fan, you can easily identify and replace it by noting down the fan numbers on the cooling fan assembly.

About this task

This error can be caused by the following reasons :
● The fan installed is not compatible with the server
● Ambient temperature is higher than the system specific ambient temperature
● External airflow is obstructed
● System cover, cooling shroud, EMI filler panel, memory module blank, or back filler bracket is missing or not installed properly
● The fans are not seated properly
● One or more fans are not functioning
● iDRAC failure on the motherboard

Recommended action

Steps

1. Update the iDRAC firmware and system BIOS to the latest version and clear the system event logs (SEL).

NOTE: System reboot is required for the BIOS update.

For more information about updating BIOS and firmware, see your systems documentation at dell.com/support.

2. Ensure that the system chassis is closed and all expansion card slots and bay covers are in place.

3. Check the internal system fans for obstructions and verify that all fans are spinning properly.

4. Reseat or swap any failing fans with a known-good fan, and replace the fan if a known-good fan works. If a known-good fan 
does not work, replace the system board.

Next steps

If the issue persists, contact Dell Global Technical Support for further assistance.

Troubleshooting cooling fans

Prerequisites

NOTE: The fan number is referenced by the management software of the system. In the event of a problem with a 

particular fan, you can easily identify and replace it by noting down the fan numbers on the cooling fan assembly.

Steps

1. Remove the system cover (front and back).

NOTE: Do not operate the system without the system cover. This can result in overheating and cause component 

damage.

2. Reseat the fan or the fan's power cable.
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3. Install the system cover (front and back).

4. Restart the system.

Next steps

If the problem persists, see the Getting help section.

Troubleshooting an internal USB key

Steps

1. Enter System Setup and ensure that the USB key port is enabled on the Integrated Devices screen.

2. Turn off the system and attached peripherals, and disconnect the system from the electrical outlet.

3. Remove the system cover.

4. Locate the USB key and reseat it.

5. Install the system cover.

6. Turn on the system and attached peripherals, and check if the USB key is functioning.

7. If the problem is not resolved, repeat step 2 and step 3.

8. Insert a known working USB key.

9. Install the system cover.

Next steps

If the problem persists, see the Getting help section.

Troubleshooting system memory

Steps

1. If the system is operational, run the appropriate diagnostic test. See the Using system diagnostics section for the available 
diagnostic tests.

If the diagnostic tests indicate a fault, follow the corrective actions provided by the diagnostic tests.

2. If the system is not operational, turn off the system and attached peripherals, and unplug the system from the power source. 
Wait at least for 10 seconds, and then reconnect the system to the power source.

3. Turn on the system and attached peripherals, and note the messages on the screen.

If an error message is displayed indicating a fault with a specific memory module, go to step 12.

4. Enter System Setup, and check the system memory setting. Make any changes to the memory settings, if needed.

If the memory settings match the installed memory but the problem still persists, go to step 12.

5. Turn off the system and attached peripherals, and disconnect the system from the electrical outlet.

6. Remove the system cover or sled from the chassis.

7. Check the memory channels and ensure that they are populated correctly.

NOTE: See the system event log or system messages for the location of the failed memory module. Reinstall the 

memory device.

8. Reseat the memory modules in their sockets.

9. Install the system cover.

10. Enter System Setup and check the system memory setting.

If the problem is not resolved, proceed with step 11.

11. Remove the system cover.

12. If a diagnostic test or error message indicates a specific memory module as faulty, swap or replace the module with a known 
working memory module.

13. To troubleshoot an unspecified faulty memory module, replace the memory module in the first DIMM socket with a module of 
the same type and capacity.
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If an error message is displayed on the screen, this may indicate a problem with the installed DIMM type(s), incorrect DIMM 
installation, or defective DIMM(s). Follow the on-screen instructions to resolve the problem.

14. Install the system cover.

15. As the system boots, observe any error message that is displayed and the diagnostic indicators on the front of the system.

16. If the memory problem persists, repeat step 12 through step 15 for each memory module installed.

Next steps

If the problem persists, see the Getting help section.

Troubleshooting no power issues

Steps

1. Swap the AC power cable with a known-good power cable.
If the system works with a known-good AC power cable, replace the power cable. (optional).

2. Reset the power supply.

a. Verify that the power source is working properly by connecting a device that draws a similar amount of power.

3. Reseat the SP suitcase into the chassis.

4. Replace the power supply.

The server does not turn on by using the front the ear node.

5. Ensure the proper power is going to the chassis.

6. Ensure all power supplies are firmly seated, power cables are connected, and both power supplies are operating.

7. Turn on the server by using the power button.

Next steps

If the server is turned on, do the following checks (optional):
● Reseat the power cable from the Interposer Extender to the system board and test.
● Reseat the cables from the mid-plane to the corresponding ear board and test.
● If the server does not turn on by using ear board, replace the ear board, fan controller board, mid-planes, and cables.

Troubleshooting power supply units

Prerequisites

NOTE: While replacing the hot swappable PSU, after next server boot; the new PSU automatically updates to the same 

firmware and configuration of the replaced one. For updating to the latest firmware and changing the configuration, see the 

Lifecycle Controller User's Guide at iDRAC Manuals.

The following sections provide information on troubleshooting power source and power supply units problems.

NOTE: Power Supply Units (PSUs) are hot swappable or cabled.

Troubleshooting power supply unit problems

Steps

1. Ensure that no loose connections exist.

For example, loose power cables.

2. Ensure that the power supply unit or handle LED if applicable, indicates that the power supply is working properly.

3. If you have recently upgraded your system, ensure that the power supply unit has enough power to support the new system.

4. If you have a redundant power supply configuration, ensure that both the power supply units are of the same type and 
wattage.

5. If your system supports Extended Power Performance (EPP), ensure that you use only power supply units with the 
Extended Power Performance (EPP) label on the back.
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6. Reseat the power supply unit.

NOTE: After installing a power supply unit, allow several seconds for the system to recognize the power supply unit and 

determine if it is working properly.

If the problem persists, see the Get help section.

Troubleshooting thermal issue

Thermal issues can occur due to malfunctioning ambient temperature sensors, malfunctioning fans, dusty heat sinks, and 
malfunctioning thermal sensors and so on.

To resolve the thermal issues:

1. Check the LCD and Embedded System Management (ESM) logs for any additional error messages to identify the faulty 
component.

2. Ensure that airflow to the machine is not blocked. Placing it in an enclosed area or blocking the air vent, can cause it to 
overheat. If installed in a rack, ensure that the rack cooling system is working normally.

3. Check for the ambient temperature is within acceptable levels.
4. Check the internal system fans for obstructions and ensure that all fans are spinning properly. Swap any failing fans with a 

known-good fan for testing.
5. Ensure that all the required shrouds and blanks are installed.
6. Check if all the fans are functioning properly, the heat sink is installed correctly, and thermal grease is applied.

Troubleshooting RAID

For information on troubleshooting RAID, see how to troubleshoot RAID, Hard Drive, and PERC.

Troubleshooting expansion cards

Prerequisites

NOTE: When troubleshooting an expansion card, you also have to see the documentation for your operating system and the 

expansion card.

NOTE: Riser slots are not hot-pluggable.

Steps

1. Run the appropriate diagnostic test. See the Using system diagnostics section.

2. Power off the system and attached peripherals, and disconnect the system from the electrical outlet.

3. Remove the system cover.

4. Ensure that each expansion card is firmly seated in its connector.

5. Install the system cover.

6. Power on the system and attached peripherals.

7. If the problem is not resolved, Power off the system and attached peripherals, and disconnect the system from the electrical 
outlet.

8. Remove the system cover.

9. Remove all expansion cards installed in the system.

10. Install the system cover.

11. Run the appropriate diagnostic test. See the Using system diagnostics section.

If the tests fail, see the Getting help section.

12. For each expansion card you removed in step 8, perform the following steps:

a. Power off the system and attached peripherals, and disconnect the system from the electrical outlet.
b. Remove the system cover.
c. Reinstall one of the expansion cards.
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d. Install the system cover.
e. Run the appropriate diagnostic test. See the Using system diagnostics section.

Next steps

If the problem persists, see the Getting help section.

Troubleshooting an optical drive

Steps

1. Try using a different CD or DVD.

2. If the problem is not resolved, enter System Setup and ensure that the integrated SATA controller and the drive's SATA port 
are enabled.

3. Run the appropriate diagnostic test.

4. Turn off the system and attached peripherals, and disconnect the system from the electrical outlet.

5. If installed, remove the bezel.

6. Remove the system cover.

7. Ensure that the interface cable is securely connected to the optical drive and to the controller.

8. Ensure that a power cable is properly connected to the drive.

9. Install the system cover.

Next steps

If the problem persists, see the Getting help section.

Troubleshooting a micro SD card

Prerequisites

NOTE: Certain micro SD cards have a physical write-protect power on the card. If the write-protect switch is Powered on, 

the micro SD card is not writable.

NOTE: IDSDM and vFlash slots are not hot-pluggable.

Steps

1. Enter System Setup, and ensure that the Internal SD Card Port is enabled.

2. Power off the system, including any attached peripherals, and disconnect the system from the electrical outlet.

3. Remove the system cover.

NOTE: When an SD card failure occurs, the internal dual SD module controller notifies the system. On the next restart, 

the system displayed a message indicating the failure. If redundancy is enabled at the time of SD card failure, a critical 

alert is logged and chassis health will degrade.

4. Replace the failed micro SD card with a new micro SD card.

5. Install the system cover.

6. Reconnect the system to its electrical outlet and Power on the system, including any attached peripherals.

7. Enter System Setup, and ensure that the Internal SD Card Port and Internal SD Card Redundancy modes are set to the 
needed modes.

Verify that the correct SD slot is set as Primary SD Card.

8. Check if the micro SD card is functioning properly.

9. If the Internal SD Card Redundancy option is set to Enabled at the time of the SD card failure, the system prompts you 
to perform a rebuild.

NOTE: The rebuild is always sourced from the primary SD card to the secondary SD card.
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Troubleshooting hard drives

For information on troubleshooting hard drives, see how to troubleshoot hard drives.

Troubleshooting a storage controller

For information on troubleshooting a storage controller, see how to troubleshoot storage controllers.

Troubleshooting processor

For information on troubleshooting processor, see how to troubleshoot processors.

Server management software issues

This section helps to manage software issues related to the server management. For more information, see article How to 
configure the iDRAC & System Management Options on servers.

What are the different types of iDRAC licenses

There are three types of the iDRAC licenses:

● Basic Management — Basic Management which was earlier known as BMC, was the default iDRAC version for the 11th 
generation of the servers ranging between 200–500 series.

● Express — iDRAC Express is the standard, default offering that is part of the base configuration for 600 series and above. 
It does not require license installation, back up, or license management. Express offers embedded tools, console integration, 
and simplified remote access.
○ Express for Blades — For the 12th and 13th generation blade servers, there is a new Express for Blades iDRAC version. 

It offers a single-user virtual console session and virtual media in addition to the standard Express offerings.
● Enterprise — There are two types of Enterprise licenses, based on the type and the duration.

○ Evaluation - This license is for a 30-day trial of certain features. It can be used on any system.

NOTE: This is not recommended for the production environment.

○ Perpetual - This license is valid for the life of the product. It does not expire and never needs to be renewed. It must be 
bound to only one service tag at a time.

For more information on the iDRAC licensing feature, see the iDRAC9 user guide.

How to activate a license on iDRAC

You can manage your license by creating your account and access License Management portal. It enables you to view your 
digital licenses, obtain a replacement license, or reassign licenses to different hardware.

To create an account:

● Go to Dell Digital Locker.
● Click Create an Account
● Enter the required information and click Create Account.
● Click Sign In, the end-user license agreement is displayed.
● Review the Dell Software License Agreement, and click Yes, I Agree button. You are redirected to the License 

Management portal.

To activate the license:

● Log in to the License Management portal.
● Click Activate Licenses tab.
● To activate the license, navigate to the license and click Assign License.
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NOTE: All the licenses must be associated with the asset. The Activate Licenses tab lists the licenses that must be 

bound to an asset.

For more information about the iDRAC license import and export, see How to import and export an iDRAC license.

Can I upgrade the iDRAC license from Express to Enterprise or 
BMC to Express

You can upgrade the iDRAC license from Express to Enterprise or BMC to either Express or Enterprise without having to open 
the box or install any hardware.

Request for the type of the iDRAC license you require by providing the service tag number of your server. Once you receive the 
license file in the .xml format, save it in your local drive to replace the license with the existing one.

To upgrade or replace the existing license:

● Log in to the iDRAC web interface.
● On the left navigation pane, click Overview, click Server, and then click Licenses.
● From the License Options drop-down list, select Replace. Click Browse to navigate to the local folder where the license 

file is saved.
● Select the license file and click Open.
● Click Apply to upgrade or replace the new license file.

The purchase of a new PowerEdge server with iDRAC8 is the same as it was with iDRAC7. For the 600 series servers and 
above, all the hardware required for iDRAC Enterprise is on the system board. Not only does this eliminate the possibility of a 
card unseating during shipping, but it also allows for an upgrade if available. If Enterprise is ordered from Dell at point of sale on 
200-500 series servers, the necessary hardware is installed in the factory. This piece of hardware is the Dell Ports card, which 
sits in a PCIe slot and has the RJ-45 connector for the dedicated NIC and the slot for the vFlash SD card.

For more information on the iDRAC licensing installation, see How to import and export idrac licenses.

How to set up e-mail alerts

You can set up an e-mail alert message which can be sent to one or more e-mail addresses. When iDRAC senses a platform 
event, such as an environmental warning or a component failure, an alert message is sent to a designated e-mail address.

To configure e-mail alerts, see How to configure Integrated Dell Remote Access Controller (iDRAC) Email Alerts.

System time zone is not synchronized

You can configure the time zone on iDRAC and synchronize the iDRAC time using Network Time Protocol (NTP) instead of BIOS 
or host system times. You must have configure privilege to configure time zone or NTP settings.

About this task

To configure time zone and NTP using iDRAC web interface:

Steps

1. Go to Overview > iDRAC Settings > Properties > Settings.
The Time zone and NTP page is displayed.

2. To configure the time zone, from the Time Zone drop-down list, select the required time zone, and then click Apply.

3. To configure NTP, enable NTP, enter the NTP server addresses, and then click Apply.

For information about the fields, see iDRAC Online Help.

Next steps

To configure time zone and NTP, use the set command with the objects in the iDRAC.Time and iDRAC.NTPConfigGroup 
group.

For troubleshooting NTP sync issues, see ECS: NTP does not sync to hardware clock.
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How to configure network settings using Lifecycle Controller

About this task

To configure network settings using Lifecycle Controller, perform the below steps:

Steps

1. Launch the Lifecycle Controller.

2. On the left pane, click Settings.

3. On the Settings pane, click Network Settings.

4. From the NIC Card drop-down menu, select the NIC port that you want to configure.

NOTE: You can use select one NIC at a time to communicate with the network.

5. From the IPV4 Network Settings→ IP Address Source drop-down menu, select one of the following options:
● No Configuration — indicates that the NIC must not be configured.
● DHCP — indicates that the NIC must be configured using an IP address from a DHCP server. If DHCP is selected, a 

DHCP IP address is displayed on the Network Settings page.
● Static IP — indicates that the NIC must be configured using a static IP. Type the IP Address Properties— IP 

Address, Subnet Mask, Default Gateway, and DNS Address. If you do not have this information, contact your 
network administrator.

6. From the IPV6 Network Settings→ IP Address Source drop-down menu, select one of the following options:
● No Configuration — indicates that the NIC must not be configured.
● DHCPv6 — indicates that the NIC must be configured using an IP address from a DHCPv6 server. If DHCPv6 is 

selected, a DHCPv6 IP address is displayed on the Network Settings page.
NOTE: While configuring DHCP server with IPv6, the configuration fails if you disable forwarding or advertising 

options.

● Static IP — indicates that the NIC must be configured using a static IP. Type the IP Address Properties—IP 
Address, Subnet Mask, Default Gateway, and DNS Address. If you do not have this information, contact your 
network administrator.

7. Click Enabled, and type the VLAN ID and Priority under Lifecycle Controller VLAN Settings.

You cannot configure the VLAN settlings of the following NICs:
● Emulex SeaHawk-2 (FH) PCIe Adapter
● Emulex SeaHawk-2 (LP) PCIe Adapter
● Emulex Vindicator-2 rNDC
● Emulex Sea Stallion-2 Mezzanine Card
● Emulex Pave Low-2 bNDC
● Emulex SeaHawk-2 (FH) NIC Only PCIe Adapter
● Emulex SeaHawk-2 (LP) NIC Only PCIe Adapter
● Emulex Vindicator-2 NIC Only rNDC
● Emulex Sea Stallion-2 NIC Only Mezzanine Card
● Emulex Pave Low-2 NIC Only bNDC

8. Click Next.

NOTE: If the Lifecycle Controller settings are not correctly configured, an error message is displayed.

NOTE: If you are unable to connect to a network, verify the settings. For information about correct network settings, 

contact your network administrator.

To configure iDRAC network using Lifecycle Controller, see How to configure the Integrated Dell Remote Access Controller 
9 (iDRAC9) with Lifecycle Controller network settings.
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Assigning hot spare with OMSA

Assigning And unassigning global hot spare

NOTE: To assign global hot spare drives, ensure that you have installed the latest version of Server Administrator. For more 

information, see the Dell OpenManage Software Support Matrix available on the support site.

A global hot spare is an unused backup disk that is part of the disk group. Hot spares remain in standby mode. When a physical 
disk that is used in a virtual disk fails, the assigned hot spare is activated to replace the failed physical disk without interrupting 
the system or requiring your intervention. When a hot spare is activated, it rebuilds the data for all redundant virtual disks that 
were using the failed physical disk.

You can change the hot spare assignment by unassigning a disk and choosing another disk as needed. You can also assign more 
than one physical disk as a global hot spare.

NOTE: On PERC S100 and S300 controllers, if there is free space available on the global hot spare, it continues to function 

as a spare even after replacing a failed physical disk.

Global hot spares must be assigned and unassigned manually. They are not assigned to specific virtual disks. If you want to 
assign a hot spare to a virtual disk (it replaces any physical disk that fails in the virtual disk), then use the assign and unassign 
dedicated hot spare.

NOTE: When deleting virtual disks, all assigned global hot spares may be automatically unassigned when the last virtual disk 

that is associated with the controller is deleted. When the last virtual disk of a disk group is deleted, all assigned dedicated 

hot spares automatically become global hot spares.

NOTE: For PERC H310, H700, H710, H710P, H800, H810, H330, H730, H730P, H730P MX, H740P, H745P MX, H830, 

H840, and PERC FD33xD/FD33xS controllers, if any of the drives you selected are in the spun down state, the following 

message is displayed:

The current physical drive is in the spun down state. Executing this task on this 
drive takes additional time, because the drive needs to spun up.

You should be familiar with the size requirements and other considerations that are associated with hot spares.

For more information, see How to Assign a Hard Drive in Global Hot Spare?.

How do I configure RAID using operating system deployment 
wizard

You can configure RAID using an operating System deployment wizard on the Dell Lifecycle controller. To configure RAID:

● Launch the Lifecycle Controller.
● In the left pane, click OS Deployment.
● On the OS Deployment page, click Deploy OS.
● On the Deploy OS page, click Configure RAID First, and then click Next.
● The storage controllers available for configuration are displayed in the RAID Configuration page.

NOTE: Make sure that the selected controller is not in a non-RAID mode.

● Select a storage controller. The RAID configuration options are displayed.
● Follow the instruction on the screen, complete the RAID setting tasks, and then click Finish.

The RAID configuration is applied to the virtual disks.

To create virtual disks using RAID configuration at the preferred RAID level, see How to create virtual disk.

Foreign driver on physical disk

To import a foreign configuration in the RAID controller, see How to import a “Foreign Configuration” in the RAID Controller 
using the System Setup Menu.
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Importing foreign configurations

NOTE: To make the foreign configuration effective, ensure that you have installed the latest version of Server 

Administrator. For more information, see the Dell OpenManage Software Support Matrix available on the support site.

You can import a foreign configuration only if it contains a virtual disk that is either in a Ready or Degraded state. In other 
words, all the virtual disk data must be present, but if the virtual disk is using a redundant RAID level, the additional redundant 
data is not required.

For example, if the foreign configuration contains only one side of a mirror in a RAID 1 virtual disk, then the virtual disk is in 
a Degraded state and can be imported. On the other hand, if the foreign configuration contains only one physical disk that 
was originally configured as a RAID 5 using three physical disks, then the RAID 5 virtual disk is in a Failed state and cannot be 
imported.

In addition to virtual disks, a foreign configuration may consist of a physical disk that was assigned as a hot spare on one 
controller and then moved to another controller. The Import Foreign Configuration task imports the new physical disk as a hot 
spare. If the physical disk was set as a dedicated hot spare on the previous controller, but the virtual disk to which the hot spare 
was assigned is no longer present in the foreign configuration, then the physical disk is imported as a global hot spare.

The Import Foreign Configuration task is only displayed when the controller has detected a foreign configuration. You can also 
identify whether a physical disk contains a foreign configuration (virtual disk or hot spare) by checking the physical disk state. 
If the physical disk state is Foreign, then the physical disk contains all or some portion of a virtual disk or has a hot-spare 
assignment.

Setting the check consistency rate

The Set Check Consistency Rate task changes the amount of system resources dedicated to the check the consistency rate.

The check consistency rate, configurable between 0% and 100%, represents the percentage of the system resources dedicated 
for running the check consistency task. At 0%, the check consistency has the lowest priority for the controller, takes maximum 
time to complete, and has the least impact to system performance. A check consistency rate of 0% does not mean that the 
check consistency is stopped or paused.

At 100%, the check consistency is the highest priority for the controller. The check consistency time is minimized and has the 
most impact to system performance.

Performing a Consistency Check

The Check Consistency task verifies the accuracy of the redundant (parity) information. This task only applies to redundant 
virtual disks. When necessary, the Check Consistency task rebuilds the redundant data. If the virtual disk is in a Failed 
Redundancy state, running a check consistency may be able to return the virtual disk to a Ready state.

Physical disk reported as Foreign

This topic describes the scenarios when a disk that is part of a RAID array may be reported as Foreign.

A physical disk state may be displayed as Foreign if:

● The disk is located out of the array for an extended period of time.
● The disk is removed out of the array and reseated.

To include a Foreign disk in the volume, you can clear the foreign configuration and reset the controller configuration.

Clearing the foreign configuration

Steps

1. On the iDRAC9 web interface, go to Configuration > Storage Configuration > Controller Configuration.
The Controller Configuration page is displayed.

2. In the Foreign Configuration section, from the Controller drop-down menu, select the controller for which you want to 
clear the foreign configuration.

3. From the Apply Operation Mode drop-down menu, select when you want to clear the configuration.
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NOTE: Clearing the foreign configuration deletes the virtual disk and erases all the data on the disk.

Resetting storage controller configuration

Steps

1. On the iDRAC9 web interface, go to Configuration > Storage Configuration > Controller Configuration.
The Controller Configuration page is displayed.

2. From the Actions menu, select Reset Configuration for the desired controller.

3. From the Apply Operation Mode menu, select when you want to clear the configuration.

4. Click Clear.

Updating BIOS and other firmware on 14th generation PowerEdge 
servers

BIOS and other firmware can be updated on the PowerEdge servers in different ways.

For more information, see Updating Firmware and Drivers on Dell PowerEdge Servers.

Firmware update failing from Dell's online repositories

Dell PowerEdge server may experience download failures and errors when attempting to acquire server updates using the 
Lifecycle Controller.

For more information on the iDRAC licensing installation, see lifecycle controller platform updates failing from Dell's online 
repositories .

Unable to create a partition or locate the partition and unable to 
install Microsoft Windows Server

Issue

Unable to create a partition or locate the partition and unable to install Microsoft Windows Server 2012 with an USB, or DVD or 
from network.

Solution

Ensure that the correct virtual drive (VD) partition is set as the first boot device. Install Microsoft Windows Server by using a 
USB 2.0 bootable drive.

NOTE: USB 3.0 is not natively supported during the Windows 2012 installation.

NOTE: For the list of supported operating systems, go to supported OS list.

For more information, see How to resolve the "Windows cannot be installed to disk # partition #" error when installing Windows.

JAVA support in iDRAC

About this task

For accessing iDRAC and some of its features, you need to install and configure the supported version of Java. The following are 
some of the key considerations:
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● Oracle version of Java is supported.
● Java version 8 or later is required.
● If you are using Firefox or Internet Explorer, and want to use the Java viewer to access iDRAC, configure the browser to use 

Java plug-in.
NOTE: On a 64-bit operating system, both 32-bit and 64-bit JRE versions are supported. On a 32-bit operating system, 

only 32-bit JRE version is supported.

● On Linux, Java is the default plug-in type for accessing the Virtual Console.
● When the iDRAC firmware is updated, launching Virtual Console with Java plug-in may fail. Delete the Java cache and then 

launch the Virtual Console.
● When using the Virtual Console, if you face issues such as out-of-range errors, synchronization issues, and so on, clear the 

browser’s cache to remove or delete any old versions of the viewer that may be stored on the system, and then try again.

NOTE: You must have administrator privilege to clear the browser’s cache.

○ To clear older versions of Java viewer in Windows or Linux:
￭ Using the command prompt, run javaws-viewer or javaws-uninstall. The Java Cache viewer is displayed.

￭ Delete the items titled iDRAC Virtual Console Client.
● If SSL encryption is set to 256-bit or higher and 168-bit or higher, the cryptography settings for your virtual machine 

environment (JVM, IcedTea) may require installing the Unlimited Strength Java Cryptography Extension Policy Files to 
permit usage of iDRAC plugins such as Virtual Console with this level of encryption. For information about installing the 
policy files, see the documentation for Java.

● While launching the Virtual Console using Java plug-in, you may occasionally see a Java compilation error. To resolve this, go 
to Java control panel > General > Network Settings and select Direct Connection.

How to specify language and keyboard type

To specify the language and keyboard type using Lifecycle Controller:

● Launch the Lifecycle Controller.
● On the left pane, click Settings.
● On the Settings pane, click Language and Keyboard.
● From the Language drop-down menu, select the language.
● From the Keyboard Type drop-down menu, select the keyboard type.
● Click Finish to save the new settings.

Installing managed system software on Microsoft Windows Server 
and Microsoft Hyper-V server

The server core installation option of the Microsoft Windows server and Hyper-V server operating system provides a minimal 
environment for running specific server roles that reduce the maintenance and management requirements and the attack 
surface for those server roles. A Windows server or Hyper-V server installation installs only a subset of the binaries that are 
required by the supported server roles. For example, the Explorer shell is not installed as part of a Windows server or Hyper-V 
server installation. Instead, the default user interface for a Windows server or Hyper-V server installation is the command 
prompt.

NOTE: On Windows client operating systems, to install the systems management software successfully, log in using an 

account which belongs to the Administrators group and must run the setup.exe using the option Run as administrator 

from the right-click menu.

NOTE: Log in as a built-in Administrator, Domain Administrator, or user who is a part of Domain Admins and Domain 

Users group, to install the systems management software on supported Microsoft Windows operating system. For more 

information about user privileges, see the corresponding Microsoft Windows operating system Help.
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Installing managed system software on Microsoft Windows 
operating systems

On Microsoft Windows, an autorun utility is displayed when you insert the Dell OpenManage Systems Management Tools and 
Documentation software. This utility allows you to choose the systems management software you want to install on the system.

If the autorun program does not start automatically, use the autorun program from the DVD root or the setup program in the 
SYSMGMT\srvadmin\windows directory on the Dell OpenManage Systems Management Tools and Documentation software. 
See the Dell OpenManage Systems Software Support Matrix for a list of operating systems currently supported.

NOTE: Use the Dell OpenManage Systems Management Tools and Documentation software to perform an unattended and 

scripted silent installation of the managed system software. Install and uninstall the features from the command line.

To find help installing the managed system software on Microsoft windows server, see Dell OpenManage Installation Guide — 
Microsoft Windows Version 9.1.

To find help installing the managed system software on Microsoft windows Hyper-V server, see Dell OpenManage Installation 
Guide - Microsoft Windows Version 9.1.

Installing systems management software on VMware ESXi

VMware ESXi is factory-installed on some systems. For a list of these systems, see the latest Systems Software Support 
Matrix.

Server Administrator is available as a .zip file for installing on systems running VMware ESXi. The zip file, OM-SrvAdmin-
Dell-Web-<version>-<bldno>.VIB-ESX<version>i_<bld-revno>.zip, where <version> is the supported ESXi 
version.

Download VMware vSphere Command Line Interface (vSphere CLI) from vmware.com and install on the Microsoft Windows or 
Linux system. Alternately, you can import VMware vSphere Management Assistant (vMA) to the ESXi host.

For more information, see Installing Managed System Software On Supported Linux and VMware ESXi operating systems.

SSD is not detected

About this task

If solid state drive (SSD) is not detected by server operating system, you must update all firmware versions including 
OpenManage Server Administrator. To update firmware version, do the following:

Steps

1. Download the latest versions of the supported firmware and drivers. For more information downloading the latest firmware, 
see the Downloading firmware and drivers section.

2. Double click the downloaded file, and follow the on-screen instructions to install the latest firmware or drivers.

TRIM or UNMAP and Dell Enterprise SSD drives support

Certain operating systems support the TRIM function, which translates deleted files to the associated LBA (logical block 
address) on the storage device (SSD). For SATA, the command is referred to as TRIM, for SAS, the command is called UNMAP. 
The TRIM or UNMAP command notifies the drive that it no longer needs data in certain Logical Block Addresses (LBA) which 
then free up several NAND pages.

The TRIM or UNMAP command must be supported by the operating system, the drive, and the controller in order to work. The 
TRIM or UNMAP command could result in higher SSD performance from both the reduced data needed to be rewritten during 
garbage collection and the higher free space resulting on the drive. Dell enterprise drives which are currently shipped have high 
performance and endurance so they do not yet support these commands even if the OS supports them. These features are 
being investigated for subsequent Dell SSD offerings.
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Unable to connect to iDRAC port through a switch

You can use iDRAC through various interfaces and methods. The interfaces include web interface, RACADM, Redfish, and so on. 
You can connect to iDRAC either locally or remotely.

If you try to connect to iDRAC using the iDRAC port through a switch, you may need to perform additional configuration on the 
switch to allow the connection to be successful. Alternatively, bypass the switch and connect the system directly to the iDRAC 
port.

NOTE: For more information on connecting to iDRAC, see the iDRAC manuals at idrac manuals.

Guidance on remote desktop services

A Remote Desktop Services deployment is the infrastructure used to share applications and resources with users. Depending on 
the experience you want to provide, you can make it as small or complex as you need. Remote Desktop deployments are easily 
scaled. You can increase and decrease Remote Desktop Web Access, Gateway, Connection Broker and Session Host servers at 
will. You can use Remote Desktop Connection Broker to distribute workloads. Active Directory based authentication provides a 
highly secure environment. For more information, see Build and Deploy Remote Desktop Services.

NOTE: Provide the correct Microsoft Windows version while purchasing the license.

Lifecycle Controller is not recognizing USB in UEFI mode

When there are combinations of servers connected, you need to use the same mode for all servers. If USB driver is not 
recognized on Lifecycle Controller, you can install on BIOS mode and not on UEFI mode.

OpenManage Essentials does not recognize the server

About this task

OpenManage Essentials does not recognize the server. To setup a new discovery range and inventory and enable WMI protocol.

Steps

1. Launch OpenManage Essentials.

2. Navigate to Manage > Discovery and Inventory.

3. In the left panel, click Add Discovery Range.

4. Enter the IP address of the specific client device or the IP range having all the client devices with the subnet mask details.

5. Click Next.

6. In the ICMP Configuration page, click Next.

7. Protocol Selection

From Dell Command | Monitor 9.0 onwards, both SNMP and WMI protocols are supported for discovery and inventory. 
Select the required protocols (only SNMP or only WMI or both SNMP and WMI) and enter the required information.

It is recommended to use WMI protocol for discovery and inventory. The difference of inventory information fetched using 
WMI versus SNMP protocol is specified. Fetching of hardware logs is possible only using WMI protocol.

● For discovery and inventory through SNMP protocol, set the community strings in the SNMP Configuration page.
● To disable SNMP discovery, uncheck the Enable SNMP discovery.
● For discovery and inventory through WMI protocol, click Next, otherwise click Finish.
● In the WMI configuration page, select Enable WMI discovery. Provide the WMI credentials of the remote device.
● Click Finish.

NOTE: OpenManage Essentials version 2.5 is the final release. OpenManage Essentials will not support current or 

future PowerEdge servers and no further product enhancements are added. Dell recommends migration to OpenManage 

Enterprise for management of your Dell devices. For more information, see Support for OpenManage Essentials.
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OpenManage Essentials does not recognize the server

About this task

OpenManage Essentials does not recognize the server. To setup the a new discovery range and inventory and enable WMI 
protocol.

Steps

1. Launch OpenManage Essentials.

2. Navigate to Manage > Discovery and Inventory.

3. In the left panel, click Add Discovery Range.

4. Enter the IP address of the specific client device or the IP range having all the client devices with the subnet mask details.

5. Click Next.

6. In the ICMP Configuration page, click Next.

7. Protocol Selection

From Dell Command | Monitor 9.0 onwards, both SNMP and WMI protocols are supported for discovery and inventory. 
Select the required protocols (only SNMP or only WMI or both SNMP and WMI) and enter the required information.

It is recommended to use WMI protocol for discovery and inventory. The difference of inventory information fetched using 
WMI versus SNMP protocol is specified. Fetching of hardware logs is possible only using WMI protocol.

● For discovery and inventory through SNMP protocol, set the community strings in SNMP Configuration page.
● To disable SNMP discovery uncheck the Enable SNMP discovery.
● For discovery and inventory through WMI protocol, click Next, otherwise click Finish.
● In the WMI configuration page, select Enable WMI discovery. Provide the WMI credentials of remote device.
● Click Finish.

Troubleshooting operating system issues

This section helps you troubleshoot operating system issues in your system.

NOTE: If the problem persists, contact Dell Technical Support for further assistance.

How to install the operating system on a Dell PowerEdge Server

Issue

Installing the operating system using Lifecycle Controller on a Dell PowerEdge server.

Solution

For detailed guidelines about installing the operating system using Lifecycle Controller, see How to install the operating system 
on a Dell PowerEdge Server (OS deployment)? .

NOTE: Update all the driver version to the latest version.

Installing and reinstalling Microsoft Windows Server 2016

You can use one of the following methods to install the Microsoft Windows Server 2016 operating system, if you do not have it 
installed on your server or if you wish to reinstall it:
● Install Windows Server 2016 by using the Dell LifeCycle Controller
● Installing the Operating System using the Windows Server 2016 Media
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NOTE: Dell highly recommends that you install the latest hotfixes and security updates from Microsoft on your system by 

using Windows updates or by downloading the latest updates after installing the operating system.

Locating the VMware and Windows licensing

For information on the location of the licenses on Dell PowerEdge servers, see Microsoft Windows Server Certificate of 
Authenticity on Dell PowerEdge Servers.

For information on how to register and activate the license, see How to Register and Activate VMware OEM Product Licenses 
using the Digital Download Locker.

Install Windows Server by using Dell LifeCycle Controller

About this task

To install Microsoft Windows Server 2012 R2 2016 for Standard, Datacenter, Foundation, and the Essentials edition by using the 
LifeCycle Controller.

NOTE: Microsoft Windows Server 2016 deployment by using LifeCycle Controller on 12th generation of the PowerEdge 

servers is not supported. Instead select the Any Other Operating System option and continue the deployment.

Steps

1. Connect the keyboard, monitor, mouse, and any additional peripherals to your system.

2. Turn on the system and attached peripherals.

3. Press F10 in the POST to start the System Services.

For 12th and 13th generation of the PowerEdge servers, the following message is displayed:

Entering Lifecycle Controller

4. Press F10 in the POST to start the System Services.

For Dell’s 11th generation of the PowerEdge servers, the following messages are displayed:

Initializing UEFI. Please wait...

and

Entering System Services...Starting LifeCycle Controller

For Dell’s 12th generation of the PowerEdge servers, the following message is displayed:

Entering Lifecycle Controller

5. In the LifeCycle Controller window, click the appropriate option if you want to configure hardware, diagnostics, or set 
changes.

If no changes are required, select OS Deployment.

6. In the Operating System Deployment window, click Deploy OS.
The Configure or Skip RAID window is displayed. If Redundant Array of Independent Disks (RAID) is configured, the 
window displays the existing RAID configuration details.

7. Select Go Directly to OS Deployment.

If RAID is not yet configured, configure currently or from this screen before proceeding with the installation.

8. Click Next.
The Select Operating System window is displayed with a list of compatible operating systems.

9. Select Microsoft Windows Server 2012 R2 Microsoft Windows Server 2016, and then click Next.

NOTE: If Microsoft Windows Server 2012 R2Microsoft Windows Server 2016 is not listed, you need to update 

the LifeCycle Controller's Drivers for OS Deployment package and then restart the Installation again from Lifecycle 

controller. select Any Other Operating System and click Next.
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NOTE: Installation of Microsoft Windows Server 2016 by using Lifecycle Controller is only supported on 13th generation 

of the PowerEdge servers.

10. Select whether you want to deploy the operating system in UEFI or BIOS mode, and click Next.

11. In the Insert OS Media window, insert the Windows Server 2012 R2 Windows Server 2016 media, and then click Next.

12. On the Reboot the System screen, follow the instructions on the screen, and then click Finish.
If a Windows operating system is installed on your system, the following message is displayed:

Press any key to boot from the CD/DVD...Press any key to begin the installation

13. On the Windows Setup screen, select the appropriate option for Language, Time and Currency Format, and Keyboard 
or Input Method.

NOTE: This screen is not displayed for the Simplified or Traditional Chinese operating system.

14. Click Next to continue.

15. On the Microsoft Windows Server 2012 R2Microsoft Windows Server 2016 screen, click Install Now.

NOTE: In Windows Server 2016 Essentials edition, on clicking Install Now, the License terms window is displayed.

NOTE: In Windows Server 2012 R2 Essentials edition, on clicking Install Now, the License terms window is displayed.

The Operating System Install screen is displayed.

16. On the Operating System Install screen, select the operating system, and then click Next.
The License terms window is displayed.

17. Read the license agreement information. If you agree with all the information, select I accept the license terms and click 
Next.

18. On the Which Type of Installation Do You Want screen, select Custom: Install Windows only (advanced), if it is not 
selected already.

19. On the Where do you want to install Windows screen, specify the partition on which you want to install the operating 
system.

To create a partition and begin installation:
a. Click New.
b. Specify the size of the partition in MB, and click Apply. The following message is displayed:

Windows might create additional partition for system files
c. Click OK.

NOTE: The recommended minimum partition size for the primary partition is 40 GB and for the Essentials Edition 

is 60 GB. If you are installing extra memory on your system, you may require more primary partition space to 

accommodate page file and hibernation. During installation, a recommended partition size is displayed on the screen 

based on the memory size of your system. Follow the instructions on the screen. If you select Core installation, you 

require less hard drive space for the primary partition.

d. Select the newly created operating system partition, and click Next. The Installing Windows screen is displayed, and 
the installation process begins.

After the operating system is installed, the system reboots. Set the administrator password before you can log in for the first 
time.

20. On the Settings screen, enter the password, confirm the password, and then click Finish.

21. To configure your system for Windows Server 2012 R2 Essentials edition:

a. After reboot, the Set Up Windows Server 2012 R2 Essentials page is displayed. Click Change system date and time 
settings to select the date, time, and time zone settings for your server, and then click Next.
The Choose Server Installation Mode screen is displayed.

b. On the Choose Server Installation Mode screen, select the appropriate installation mode, and provide the required 
data. For a new installation select Clean install. Proceed with required inputs to configure your install.

For detailed steps on configuring your Windows Server 2012 R2 Essentials install, go to Technet.microsoft.com/en-
us/sbs/jj159331.aspx.

c. Create the Administrator user account and Standard user account and complete the installation.

22. To configure your system for Windows Server 2016 Essential Edition:
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a. After reboot, the Windows Server 2016 Essentials dashboard is displayed. Click Change system date and time 
settings to select the date, time, and time zone settings for your server, and then click Next.
The Company Information screen is displayed.

b. On the Company Information screen, type the appropriate details for the company name and the server name.
Click Next to go to the Create Network Admin account screen.

c. Create the network administrator with required account name and password. On the next screen, select Use 
recommended settings, and then click Next to complete the configuration.

The system reboots and configures to essentials.

23. On the Settings screen, type the password, confirm the password, and then click Finish.

24. The system is locked now, and you can log in to the system by pressing Ctrl+Alt+Delete.

25. After reboot, the system is locked and you can log in to the system by pressing Ctrl+Alt+Delete.

26. Type the administrator password, and then press Enter to log in to the system.

Results

The operating system installation is complete.

Install Windows Server by using operating system media

About this task

To install the Microsoft Windows Server 2012 R2 or 2016 operating system for Standard, Datacenter, Foundation, and the 
Essentials edition:

Steps

1. Connect a keyboard, monitor, mouse, and any additional peripherals to your system.

2. Turn on your system and any attached peripherals.

Several BIOS screens are displayed during startup, but do not require any user intervention.

NOTE: This method of installation is supported in the BIOS and UEFI modes.

3. Insert the Microsoft Windows Server 2012 R2 or 2016 media into the DVD drive.
The following message is displayed:

Loading Files

NOTE: If a Windows operating system is installed on your system, the following message is displayed:

Press any key to boot from the CD/DVD ... Press any key to begin the installation

4. After the files are loaded, click the appropriate language that you want to deploy.

NOTE: This screen is not displayed for the Simplified or Traditional Chinese operating system.

5. On the Windows Setup screen, select the appropriate Language, Time & Currency, and the Keyboard or Input values, 
and then click Next.

6. On the Windows Server 2012 R2 or Windows Server 2016 screen, click Install Now.

The Operating System Install screen is displayed.

NOTE: In Windows Server 2012 R2 or 2016 Essentials edition, on clicking Install Now, the License terms window is 

displayed.

7. On the Select the operating system you want to install screen, select the operating system from the available list, and 
click Next.
The license terms window is displayed.

8. Read through the license agreement information. If you agree with all the information, select I accept the license terms, 
and then click Next.

9. On the Which type of installation do you want screen, select Custom: Install Windows only (advanced) if it is not 
selected already.
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10. On the Where do you want to install Windows screen, specify the partition on which you want to install the operating 
system.

To create a partition and begin installation:
a. Click Drive options (advanced) > New.
b. Specify the size of the partition in MB, and click Apply. The following message is displayed:

To ensure that all Windows features work correctly, Windows might create additional 
partition for system files

c. Click OK.
NOTE: The recommended minimum partition size for the Primary partition Standard, Datacenter, Foundation Edition 

is 40 GB and for the Essentials Edition is 60 GB. If you are installing extra memory on your system, you may require 

more primary partition space to accommodate page file and hibernation. During installation, a recommended partition 

size is displayed on the screen based on the memory size of your system. Follow the instructions on the screen. If 

you select Core installation, you may require less hard drive space for the Primary partition. For information on 

drive partitioning see the Partitioning a drive section.

11. Select the newly-created operating system partition, and click Next.
After the operating system is installed, the system reboots. Set the administrator password before you can log in for the first 
time.

NOTE: For Windows Server 2012 R2 or 2016 Essentials edition, after the installation is complete you must configure the 

system before setting the administrator password.

12. To configure your system for Windows Server 2012 R2 Essentials edition:

a. After reboot, the Set Up Windows Server 2012 R2 Essentials page is displayed. Click Change system date and time 
settings to select the date, time, and time zone settings for your server and click Next.
The Choose server installation mode page is displayed.

b. On the Choose server installation mode page, select the appropriate installation mode, and provide the required data. 
For a new installation, select Clean install. Proceed with required inputs to configure your install.

For detailed steps on configuring your Windows Server 2012 R2 Essentials install, see Technet.microsoft.com/en-us/sbs/
jj159331.aspx.

c. Create the Administrator user account and Standard user account and complete the installation.

13. To configure your system for Windows Server 2016 Essential Edition:

a. After reboot, the Windows Server 2016 Essentials dashboard is displayed. Click Change system date and time 
settings to select the date, time, and time zone settings for your server, and then click Next.
The Company Information screen is displayed.

b. On the Company Information screen, type the appropriate details for the company name and the server name.
Click Next to go to the Create Network Admin account screen.

c. Create the network administrator with required account name and password. On the next screen, select Use 
recommended settings, and then click Next to complete the configuration.

The system reboots and configures to essentials.

14. On the Settings screen, type the password, confirm the password, and click Finish.
The system is locked.

15. The system is locked now, and you can log in to the system by pressing Ctrl+Alt+Delete.

16. After reboot, the system is locked and you can log in to the system by pressing Ctrl+Alt+Delete.

17. Type the administrator password, and then press Enter to log in to the system.

Next steps

The operating system installation is complete.
NOTE: After you log in to the system, you can use the Server Manager Dashboard to configure and manage different 

roles and features in the operating system.
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Converting evaluation OS version to retail OS version

Issue

Customer is attempting to install Windows using the license key that is provided by Dell however do not have the media at hand. 
The customer then proceed to use the evaluation version to upgrade, but the version did not match. Errors occurred when 
inserting the license key.

Corrective actions

To fix the issue:

● For 2016, see Upgrade and conversation options for Windows Server.
● For 2019, see Install, upgrade, or migrate to Windows Server.

Troubleshooting blue screen errors or BSODs

Steps

1. Identify the stop code or the stop message when the system displays the blue screen of death.

Figure 16. Blue screen of death

2. Run the PSA or ePSA diagnostics. For more information, see EPSA in the Self help section.

3. If the diagnostics pass and the issue persists, identify the stage in which the blue screen error occurs.

4. If the BSOD occurs during the boot process, check for minimum to POST components. For more information, see No POST 
situation.

If the issue persists, call Dell Technical Support.

5. If the BSOD occurs during pre-logon, boot into Safe Mode and disable all startup entries. Isolate one startup entry at a time 
until you find the causing agent.

NOTE: If you are unable to boot into Safe Mode, call Dell Technical Support.

6. If the issue persists, check for minimum to POST components. For more information, see No POST situation.

If the issue persists, call Dell Technical Support.

7. If the BSOD occurs intermittently or during post-logon, debug mini crash dump files using WinDbg.

After debugging, call Dell Technical Support with the mini dump file.
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Debugging mini crash dump files using by WinDbg in Windows operating 
system

Prerequisites

1. Click Start > Control Panel > System.

Figure 17. Opening the Systems page
2. In the System page, click Advanced system settings in the left pane.

Figure 18. Advanced system settings page
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3. In the System Properties window, click Settings under the Startup and Recovery section.

Figure 19. System Properties window
4. In the Startup and Recovery window, System failure section, do the following:

a. Select Write an event to the system log to ensure that the mini dump file is created in the event of a system failure.
b. Select Automatically restart to restart the system after a blue screen of death (BSOD) occurs.

NOTE: For servers, it is recommended that you select the Automatically restart option so that the server can 

function if the error is not critical.

c. Verify that the Overwrite any existing file option is not selected. This ensures that a record of failures is maintained if 
there are repeated occurrences of system failures.
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Figure 20. Startup and Recovery window
5. When a BSOD occurs, collect the minidump files by navigating to C:\windows\minidump.

6. Download and install the Windows Debugger (WinDbg) tool from https://msdn.microsoft.com/en-us/windows/
hardware/hh852365.aspx.

Steps

1. Open WinDbg.

2. Click File > Symbol File Path or press Ctrl + S on the keyboard.

3. In the Symbol Path field, enter SRV*<local path>*http://msdl.microsoft.com/download/symbols where, 
<local path> is the path where you want to download the symbol files.

4. Click OK.

5. Click File > Open Crash Dump or press Ctrl + D.

6. Navigate to the folder where the mini dump file is saved.

7. Select the mini dump file and click OK.

8. Click No when the system prompts to save information for workspace.

Debugging starts.

9. Click !analyze –v to get detailed debugging information.

10. Note down the values for the following parameters:

a. DEFAULT_BUCKET_ID
b. MODULE_NAME
c. IMAGE_NAME

11. Call Dell Technical Support for further assistance.
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Troubleshooting a purple screen of death or PSOD

For information on troubleshooting a PSOD, see Troubleshooting a Purple Screen of Death and Interpreting a purple screen of 
death.

Troubleshooting no boot issues for Windows operating systems

Steps

1. Check the hard drive status in the PERC BIOS. For more information, see PERC BIOS configuration utility.

2. Boot the server in the safe mode.

NOTE: If the server is a domain controller, boot the server in Directory Services Repair Mode (DSRM).

If the server boots successfully, the issue is with an installed driver, application, or service. Proceed to Step 4.

3. For Windows Server, you can perform the following recovery options:

● Use the bootrec command to troubleshoot startup issues. For more information, see Troubleshoot startup issues .

● Use the chkdsk tool to determine whether there is a disk problem. For more information, see Chkdsk
● Use DiskPart to verify the status of disk partitions. For more information. see Diskpart.
● Use the bcdedit utility to view or modify the boot configuration database (BCD). For more information, see Bcdedit.

NOTE: For additional recovery console commands, see How to use the Recovery Console.

NOTE: For more troubleshooting steps, see How to troubleshoot startup problems in Windows server 2003.

4. From within the safe mode or DSRM, use the msconfig utility to disable startup applications and non-Microsoft services on 
the server.

5. Reboot the server in the normal mode.

6. If the server boots, use the msconfig utility to identify the disrupting service or application by enabling services and startup 
applications one at a time and rebooting the server until the server fails to boot.

7. If the issue persists, use Dell's Linux-based OMSA LiveCD to boot the system and run diagnostic tests to determine whether 
any hardware is malfunctioning.

OMSA LiveCD can also be used to recover data from a server whose operating system does not start.

No boot device found error message is displayed

Description—After the server completes the Power On Self-Test (POST) phase, the server is unable to boot a bootable device. 
This condition is called No Boot. Files available in a bootable device—RAID, USB key, DVD, or ISO file—contain instructions to 
start the operating system. When these files cannot be located, an error message—No boot device found—is displayed. You 
may observe this issue if the virtual disks are not online, due to a hard drive or PowerEdge RAID Controller (PERC) issue.

About this task

Workaround—Perform the following steps:

Steps

1. Check the hard drive status in the PERC BIOS.
An error message—No boot device found—is displayed.

2. Press Ctrl + R during the POST process to open the PERC BIOS Configuration Utility.

3. To check if the hard drive is part of the RAID array, do the following:

a. Press Ctrl + N to navigate to the PD Mgmt (Physical Disk Management) screen.
b. Check if any hard drives are offline or missing.

Table 34. Hard drive status 

Hard drive status Description

Offline Hard drive is not part of the RAID array.
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Table 34. Hard drive status (continued)

Hard drive status Description

Online Hard drive is part of the RAID array

Ready Hard dive is ready to be a part of the RAID array

c. Check that the Virtual Disk is online in an optimal state.

4. Click the CTRL Mgmt tab, and select the Virtual Drive where the operating system is installed.

When the RAID is managing multiple Virtual Drive, it is important to select which Virtual Drive has to be presented when the 
server tries to boot on the raid controller.

5. If the problem persists, call Dell Technical Support for further assistance.

No POST issues in iDRAC

This section provides details on troubleshooting iDRAC issues.

First Boot Device cannot be set error message is displayed when configuring a boot 
device during POST.

Description - The error message First Boot Device cannot be set

Either the system BIOS is out-of-date, or the server needs a reboot for the settings to take effect” displays in the POST mode.

Resolution

Allow the server to completely boot to the OS or turn off the server before setting a vFlash partition to the first boot device. 
This allows the server to boot to the vFlash partition and the error will no longer be seen.

Troubleshooting a No POST situation

Power On Self Test (POST) is a series of diagnostic tests that run automatically when you turn on your system. POST tests the 
memory, the keyboard and the disk drivers. If the test is successful, the computer boots itself, else the system displays an LED 
error or an error message in the LCD panel. This situation is called No POST.

Prerequisites

NOTE: When removing or replacing parts, always turn off the server, remove the power cord, and wait for ten seconds 

for the static flea power to drain. Reconnect the power cord, wait for a minute and turn on the server. This allows time 

for the Baseboard Management Controller (BMC) to power up. Error messages may not be reported correctly if the static 

flea power is not fully drained. For more information on removing and installing hardware components, see your system’s 

Owner’s Manual at PowerEdge manuals.

NOTE: Ensure that you give enough time for the server to POST. Newer systems may take up to three minutes before 

any video appears during the POST. During this period, a message on the LCD screen is displayed, which indicates that the 

server is booting.

Steps

1. Check the LCD screen or LED indicators for any error messages.

For information about the event and error messages generated by the system firmware and agents that monitor system 
components, go to QRL > Look Up > Error Code, type the error code, and then click Look it up..

2. Ensure that the server is turned on by verifying that the power supply LED glows green.
If the power LED is lit amber, see system health and system id indicator codes topic.

3. Remove all the Electrostatic Discharge (ESD) from the server.

a. Turn off the server.
b. Disconnect all cables from the server including the power cable.
c. Press and hold the power button for 60 seconds to discharge.
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d. Reconnect the power and video cable only.
e. Turn on the server.

If the server fails to POST, proceed to the next step.

4. Disconnect all cables from the server including the power cable.

5. Bring the server to the minimum configuration for the POST.

NOTE: Minimum to POST configuration is the config that has the minimum components required to complete POST. 

Typically, the minimum to POST configuration for rack servers is PSU1, CPU1, memory module in A1 slot, and the default 

riser without expansion cards. For tower servers, the minimum to POST configuration is PSU1, CPU1, and memory 

module in A1 slot. For modular servers, the minimum to POST configuration is CPU1 and memory module in A1 slot.

6. Reconnect the power and video cable only.

7. Attempt to POST the server.

a. If the server completes the POST, turn off the server and plug the components one at a time until the defective part is 
found.

If you identify the defective part, contact Dell Technical Support with information about the defective part.

b. If you are unable to identify the defective part, go to the next step.

8. Disconnect the hard drives, optical drives, and tape drives from the server and attempt to POST the server.

a. If the server completes the POST, plug the hard drives back one at a time until the defective hard drives are found.

If you identify the defective part, contact Dell Technical Support with information about the defective part.

b. If you are unable to identify the defective part, go to the next step.

9. Reseat the control panel connector.

10. Ensure that the processors and heat sinks are seated correctly.

11. If the server does not complete the POST, clear the NVRAM using the jumper.

For more information , see your system’s Owner’s manual at PowerEdge manuals.

Next steps

If the issue still persists, contact Dell Technical Support for assistance. Also for more information see NO POST situation.

Migrating to OneDrive for Business using Dell Migration Suite for 
SharePoint

About this task

To connect to OneDrive for Business:

Steps

1. Login to a SharePoint Online site in the browser.

2. Click on the OneDrive link in the header at the top of an Office 365 page.

3. Сopy the site URL from the browser's address line.

4. Open the application and specify the OneDrive URL in the Connect to SharePoint wizard.

NOTE: Before connecting the OneDrive site of another user, make sure the OneDrive has been provisioned (i.e. the 

OneDrive site owner has visited it at least once) and you have administrator permissions granted either by the OneDrive 

site owner or using the Set-SPOUser commandlet (Set-SPOUser).

Configuration backup and restore procedures

Dell recommends that you back up your VMware ESXi configuration after you complete the initial setup on a routine schedule 
that fits your data center environment. Backing up your configuration captures the license code (host serial number).

To back up or restore the configuration information, use the VMware vSphere CLI. The vSphere CLI is available in:
● vSphere CLI package — The vSphere CLI package can be installed on either Linux or on Microsoft Windows operating 

systems.
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● vSphere Management Assistant (vMA) — vMA can be deployed on an ESXi host.

Both of this software is available for download from vmware.com. For more information on setting up and running the vSphere 
CLI, see the VMware vSphere Command-Line Interface Installation and Reference Guide and VMware ESXi Embedded and 
vCenter Server Setup Guide at vmware.com/support/pubs.

The backup and restore steps are given in this section considering that:

● You have already imported the vSphere CLI to a system other than the one you want to back up or restore.
● You have installed the Windows or Linux management Application Programming Interfaces (APIs).

Backing up the configuration of your ESXi host

About this task

To back up configuration data of a host:

Steps

1. Start the vSphere CLI.

2. Run the vicfg-cfgbackup command with the -s flag to save the host configuration to the specified backup filename:

vicfg-cfgbackup --server< ESXi-host-ip> -- portnumber <port_number> --protocol 
<protocol_type> --username root --password root_password [-s <backup-filename>

The -portnumber and -protocol options are optional. If you exclude them, the defaults are port 443 and protocol 
HTTPS.

NOTE: If you do not specify a password in the command line, you are prompted for one when the command executes. 

For example: vicfgcfgbackup --server 172.17.13.211 --username root –s backupdate.dat

NOTE: If your administrative password includes special characters, such as $ or &, you must include a backslash escape 

character (\) before each special character.

Restoring configuration of your ESXi host

About this task

To restore the configuration data of a host:
NOTE: The backup process does not support restoring to later builds. This requirement can be overridden by using the –f 

option.

Steps

1. Turn off any VM that is running on the host you want to restore.

2. Optionally, restore the host to the ESXi build number used when the backup file was created.

3. Start the vSphere CLI on a host other than the host you want to restore and log in.

4. Run the vicfg-cfgbackup command with the –l flag to load and restore the backup file to the host.

vicfg-cfgbackup --server <ESXi-host-IP> -- portnumber <port_number> --protocol 
<protocol_type>-- username <username> --password <password> -l <backup_filename>

The -portnumber and -protocol options are optional. If you exclude them, the defaults are port 443 and protocol HTTPS.

NOTE: If you do not specify a password in the command line, you are prompted for one when the command executes. 

For example: vicfgcfgbackup --server 172.17.13.211 --username root –l backupdate.dat
After a successful restore, the system reboots using the new configuration. For complete instructions on backup and restore 
commands, see VMware ESXi Embedded and vCenter Server Setup Guide at vmware.com/support/pubs.

64 Self help

https://www.vmware.com/support/pubs/


Install, update, and manage Fusion-IO drives in Windows OS

Issue: Customer is trying to install ioSphere and are having problems with password credentials.

Corrective action:

To fix the issue, ioSphere needs to be reinstalled. The link below contains information about installing, updating and managing 
Fusion-IO, which contains information about installing ioSphere: How to Install, Update, and Manage Fusion-IO Drives.

Linux

FAQs

Why are network ports displayed as unknown in YaST2 network configuration in SUSE Linux 
Enterprise?

While configuring a bonding interface, the configured bond-slaves are listed as Unknown Network Device. The YaST installer 
is unable to write the device name in to the ifcfg files. Delete the existing configuration of previously configured network 
interfaces.

Symptoms

Unable to boot from iSCSI when static IPv6 address is assigned to the initiator

Description

The SUSE Linux Enterprise Server 12 does not boot from iSCSI over IPv6 address after successful installation, when static IPv6 
address is assigned to the initiator.

Resolution

Use Dynamic Host Configuration Protocol (DHCP) address for the initiator.
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Get help
This section covers information on how to gather logs before contacting Technical support and how to contact Dell 
Technologies.

Topics:

• Gathering logs for troubleshooting on PowerEdge servers
• Contacting Dell Technologies

Gathering logs for troubleshooting on PowerEdge 
servers
To speed up the support process when faced with an issue, Dell recommends that you gather system logs before contacting 
Dell Support. When you have logs available to submit to the support agent, they will be able to review them and diagnose the 
problem immediately, which will mean the quickest possible resolution to your issue.

Table 35. When is which tool useful? 

Tools

Secure Connect Gateway on windows and on linux

Gather and read the Server Event Log (SEL) / Hardware-Log using OMSA - OpenManage Server Administrator

Export SupportAssist using iDRAC Integrated Dell Remote Access Controller

PERC logs export using software tools

CMC Logs Chassis Management Controller

Management Module

For more information see : Gathering logs for advanced troubleshooting on PowerEdge servers.

Contacting Dell Technologies
Dell provides online and telephone based support and service options. If you do not have an active internet connection, you can 
find Dell contact information on your purchase invoice, packing slip, bill or Dell product catalog. The availability of services varies 
depending on the country and product, and some services may not be available in your area. To contact Dell for sales, technical 
assistance, or customer service issues follow these steps:

Steps

1. Go to Dell Support.

2. Select your country from the drop-down menu on the lower right corner of the page.

3. For customized support:

a. Enter the system Service Tag in the Enter a Service Tag, Serial Number, Service Request, Model, or Keyword 
field.

b. Click Search.
The support page that lists the various support categories is displayed.

4. For general support:

a. Select your product category.
b. Select your product segment.

4
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c. Select your product.
The support page that lists the various support categories is displayed.

5. For contact details of Dell Global Technical Support:

a. Click Contact Technical Support.
b. The Contact Technical Support page is displayed with details to call, chat, or e-mail the Dell Global Technical Support 

team.
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